®

Bridgemale

Bridgemate ‘Pro’ Scoring system
Manual

Chapter 8: Using Bridgemates with ACBLscore

 Bridgemate normally
operated by North

o When “Verification
by East or West”
appears, East or
West must verify.

o Traveler should be
viewed by all

Bridgemate silently.

© 2004-2021 Bridge Systems BV

Adapted for North American use
Bridgemate.US, LLC — 2021



All information contained in this document is subject to change without prior warning. Unless stated otherwise, all
persons and details mentioned in this document are fictitious. No part of this publication may be reproduced and/or
published, by print, photoprint, microfilm or otherwise, or stored in a retrieval system, without prior written permission
from Bridge Systems BV.

© Copyright 2004-2021 Bridge Systems BV. All rights reserved.

Bridgemate, Bridgemate Pro and the Bridgemate logo are trademarks and/or registered trademarks of Bridge
Systems BV in the Netherlands and other countries. Microsoft and Microsoft Windows are trademarks and/or
registered trademarks of the Microsoft Corporation in the United States and other countries.

Every user should read and take notice of the Safety Instructions printed on pages 3 & 4 of this manual.

Customers who have concerns with the Bridgemate Pro Control software End User License Agreement (displayed
when Bridgemate Pro Control software is installed) and/or the Bridgemate Scoring System Limited Warranty (pages
1 and 2 of this manual) may return unused products at the customer’s expense to Bridgemate.US, LLC, for a full
refund of the purchase price — excluding shipping charges.

Bridgemate.US, LLC
350 Sawmill Creek Dr.
Nellysford, VA 22958
434-361-1397
FAX: 434-361-0220
sales@bridgemate.us
www.bridgemate.us



mailto:sales@bridgemate.us
http://www.bridgemate.us/

Table of Contents

LM I T ED MV A R R AN T Y ittt iitii ittt i ettt ettt e ettt e st e ettt e e st e e teeeeseeees e et e et eeasseestseeas e oAt eeass e e s e oA e et s e oAt e et seeas e e sbsesnsssanreesnrseanes 1
SAFETY IN S T RU C T ION S .ottt ittt ittt ittt ittt e et e e sttt e eitsee it s e eess e ettt e et e et e et e et s e easseetsseasseess s e eass e ss s e eass et s s easseebseenseesssenssasseis 3
INT ROD U C T HON L.ttt ittt ittt s it e e it e e st ee it eessseess e e ssseess s e e esseess s e e esssees e e esseees s e e osseeoh s e e o8 e e es e e s s e s e e eheseen e e et seeenseeesbeeansesanssesnsssnns 5
CHAPTER 1: DESCRIPTION BRIDGEMATE SCORING SYSTEM ...ttt ieieesieesiereesssesieseesneesnees 6
DESCRIPTION OF COMPONENTS .. .uttiiiittieeeitteeeeitteeesaitteeesatseeesssseaaatesseaassssssassesaaastsssesassssssassssasassssseaassssesssesasasseseesassssessssssesssseeeeans 6
PROCEDURE ..ottt et e e e ettt e oottt e e e bt e e e e ehee e e e sabeeeeaatbeeeaaseeeeeaabeeeeasteeeeaasseeeeaabeeeeasbeeeeaseeeesaabeeaeasteeeeasseeesasbeeasasteeaens 7
BRIDGEMATE APP......eoiiiitiii e ittt e e ettt e e ettt e e e ettee e e stbeeaeasteeeeaasseeeaaabeeaaasteeeeasseseeasbeeaeasteeeeaaseeeesaabeeaeasbseeeanseeseesabeeeeasteeeeasseeesasaeeasasteeenns 8
CHAPTER 2: HARDWARE CONFIGURATION L. itiiiitiiiitiiiiiii ittt iite ettt iittesitseestsesitseaassteisssaassteisssaaseesisreaassesisseaasseeisseesseesisees 9
SYSTEM REQUIREMENTS 11ttiitiiiiiittttittiesiieittttesssesssassssesssesssasssssssssesssasssssssssesssasssssssssssssasssssssssessssssssessssssssissssssssessssissssssssessssissssssns 9
INSTALLING BRIDGEMATE CONTROL SOFTWARE (BCS) ...iiiiiiieiiie st e sttt st e s et st st neenaena e et nnenteanaenaenes 9
INSTALLING THE SERVER ....tteittteittteiteeittteseeestteestseessseessasesssesssseesssesssssesssesssssesssesssseesssessssessssessssssssessssessssessssssssessssessssessnsessnsessnns 9
POWER SUPPLY ...ttiiuteeiteeiteesteesteessteesteessteessteessteessteessteesseeeasseeaseeeasseeaaeeeasseeaReeessbeeaReeesaeeesReeesateeaReeeaRbeeaReeensbeeaneeenabeesneeenseeesnneesnreens 9
CONNECTING THE SERVER TO THE PC ..ttt et e et e st e et e e et e s abe e e teeaate e e s beeenbe e e nbeeanbeesnbeeenbeeanteennneeanns 10
SETTING THE REGION ... uttteitteeiteeeiteeeiteeasteeesteeesssesstssasesssteeaasessssssansessssssasessssssssessssssansessssssansssssessnsessssessnsessssessnsessssesansessnsessnsessnns 10
SETTING THE CHANNEL ....tetteette ettt e iteeesteeesteeesseessteeaseessteeaassessteeansesassssassessssssasessssesasessssesansesssssasessssessnsesssssssnsessssesansessssessnsessnns 10
CONFIGURING THE BRIDGEMATES ...eiiittiieiitit e e eitteeesitteeeaateeeesatteaeastbeeaaasteseesassseesssbeeaaassseeeaassasessabeseeasteseeanssssessabeeaeantbeeesasssesssnses 11
OPERATING INSTRUGCTIONS ... .titiiittteeiitteeeeateeeestteeesatteeeaasteeeeasssaeaasseeaaastsseeassseesssseseaassseseaassasesssseeeeastsseeanssssessaseeaesnteeeeanssseessnses 11
CHAPTER 3: BRIDGEMATE CONTROL SO T W ARE ... ottt ittt e eite e s it eesireeiiteeeiseeiibeesiseesireeaaseeareeireeaans 12
LAUNCHING BRIDGEMATE CONTROL ...cciiutitiiitttieeiitteeeeetteeeeitteeaeatteeesassssssastesaaatssesaassssesassssasassssesasssssssssssesssssssesasssessssesesssseeeesns 12
LOGGING IN AND LOGGING OFF BRIDGEMATES ......uttiiiiiiiiiiteeeeaitieeeeetteeesiteesaattseeaassseessssseaaateseesassssssssesaaasseseesassssessssesasssseseesns 13
LOGGING IN BRIDGEMATE .....veiittiiteeiteeiteesteeateesssesasessssesasseesssesasssassesssssssnsessssssasesssssssnsesssssssnsesssssssnsessssssansessssssansessssesenessssens 13
LOGGING OFF BRIDGEMATE ....eciuttiittteitteeiteesteesiteessteeasteesssesssseesssesasseesssesasssssssessssesasssssssssnsesssssssnsesssssssnsessssssansessssesansessssesenessssees 13
BOARD RESULTS ..utttiutteiteestteesaeessteesteesssesasseessseessseessseessssesssesssssesssesssssssssesssssessseesssssssssessessssseessesessssessesessssensesessssanessssesensessssees 13
READING FROM THE SERVER .....ccuvtiittteitteeitteeiteestteessseessseessseesssesssseesssesssssesssesssssesssssssssssssessssssssssessesessssessssessssessesessssensessssesenessssees 13
RESULTS — ROUND MONITOR — BOARD MONITOR — RESULT IMATRIX 1...uviiiiveiiiee ittt e sieeesiveestaeestreesaaeestseessaeestseessnesstssessnesssnssssessssns 14
SUSPICIOUS CONTRACTS 11ieutteetreeiteeeiteeenseeeiteeaaseesstssaasessstssassessssssansesssssansessssssansesssssssnsesssssssnsessssssansessssssnsesssssssnsessssesansessnsessnsessnns 14
CREATING REPORTS ....eeiiiiitiie ittt ettt e e ettt e e ettt e e e tee e e s etb e e e e asteeeeeabeeaeebbeeeaasbeeeeaabeseesasbeeeeassseeeaasseeeeaabeeeeasteeeeasseeesaabesaeanteeeeansseeensnnes 15
CHANGING AND DELETING BOARD RECORDS.......ccicttteeiittteeaattteesiteeeeaatteeaaateseeaasssessassesaaassseseaasssssssssssasasssseeaassssessssesessssessesasseessnses 15
OPENING AND CLOSING RESULT ((BWS) FILES ....tiutttttestesteruteteaieentestesuestesseasesseaseeseessasaesaessesseassassensasaesbessesseaseaseansessessessessessessenns 15
USING MULTIPLE CLIENTS. .. ttttiiittteeiittteeeetteeeesteeeeastteeesastseessabseaasataseeaassseeesasssaeasteseeaasssseeassesaessteeeeaasseeeesnssseessbeeesasteeeesnsanaesasranas 16
ADDING A CLIENT TO THE RESULT ((BWS) FILE ...ttiuttutttiatesteateateaeeseeseestestesaeste st eseeseessesaesaesbesbeesee s eneesaesbesbeabeabeessenbeseesbesbesbeeneanes 16
MANAGING TABLES — TOURNAMENT (NETWORK) IMODE .....c.uttttittattetetestestestesseeseeseesseseesaestessesssssssnsesssssessessesssssssnsessessessessessesses 16
SERVER CONTROL ..uttiititeitteeitteeiteesiteeasteessteeaassesstesasessstseaassssssssasessssssansessssssansessssssanssssssesanssssssssansesssssssnsessssessnsessssessnsessnsessnsessnns 17
ACTIVATING THE SERVER....eiutteetteiteeeiteesitteaisesssteeaisessssesansessstesansessssssasssssssssasessssssansessssssansessssssansessisssansessssssanessssesenesssesenessssens 17
AADDING TABLES ...ttt ittt ittt iteeeteessteeaitesssteaasesasteeaseeateeassesasteeanseeasseeanseeasteeanseesssseanseeesteeanseeesteeanseeeseeeenseeeseeeenbeeesteeenteeeteeenneeastes 17
LY L@V N LT Y = I =SSR 17
SYNCHRONIZING THE SERVER AND CLIENT L.uttiitttiitttestteeitteeiteeeitseansessstesassesssssassesssssansesssesansesssssssnsesssessssessssessnsessssessnsessssessnsessnns 17
RECOVERING THE SERVER ....c.uttiittteitteeiteessteeisteestseessseessseessssesssesssssesssesssssesssesssssesssssssssessssessessssseensesessssesssssssssessessssesensesssssensessssees 18
UPDATING MOVEMENT IN THE SERVER. .....cciittitiiittteeiitteeeeattteeestteaesitteeesastseessssssaeaseseaaastssaesasssaesateeeeaasssseesnsssaesasbeeeaasteeeessseaesassnnas 18
CLOSING ROUNDS........utteeeitteteeatteteeeiteeeesatteeeaastessesteeaesasseeaaastssseasssaesasseeaaasteseeanssseesssbeeeeastseseassaeessaseeeeasteseeassseesanseeeesnteeeeansseeessnses 18
PROGRAM SETTINGS (OPTIONS) .....ttttittetesttaueesetestestestesseaseaseaseesseasessesseaseastassesessessessessesseassassansesssssessessessssseassessensensessessessessennes 19
BRIDGEMATE APP......eeiiiiitiie e i ettt e e et e e e ettt e e e ettt e e sabeeaeaetteeeaasteeeesabeeaestbeeeaassseeesasesaeasteeeeaasteeeeaaeesaeastbeeeaasteeeesnsesaeassbeeesastseeesnnenaessaneas 19
CHAPTER 4: SERVER FUN C T ION S L.ooiiiitiiiitiiiitiii ittt ittt e ittt s itesisteesesesssseestsetssessssaessesssesssestsesesssssssesseestbeesreesssessesanns 20
OVERVIEW OF TABLES. ...ectttiittteittt ettt eiteesiteeaateessteeaasesasteeaasssatseassesasteeassessstesansessstesansesastesasesssteeansessstessnsessssesssessstessnsesssessnsessnns 20

OVERVIEW OF ENTERED RESULTS ....uttttittattattastessetestessestesseasesssessesseasesteaseaseaseassesseasesbeaheab e s st es s e s s eabenbeab e ekt e bt eb e eseenbenbeanenbeaneareene e 20



RESTARTING BRIDGEMATE NETWORK ......uttitteiteeiteeiteesreaseasssasessmeeameeneasseas e assesmeesmeesmeesnesseessesame s ameeameesneanneas s e nn e e nneenre e reenneenneannes 20

RESETTING THE SERVER .....uvtiitteittetiiteesteesteessteessteesstesassessssesasseesssesssseesssesssseesssesssssesssesssssesssesssssesssesssssesssessssesssesssseessseesseeesnnees 20
SETTING THE REGION. ...ccttiititeitteeitteestteeitteasteeastseassesassseaasesassseaassesstssassessssssasssssssssansesssssssnsessssssansesssssssnsessssssansessssesensesssseesnsessises 21
SETTING THE CHANNEL ....eeeiittiieiiititee ittt e e itteeeeatteeesiteeeesataeeeaastaeeasasseaestesaeaassseesssbesaaastsseeassssesasseeasassseeeasseeesasbeeeeassseesssneeesssreeann 21
SYSTEM FUNCTIONS ... ttieeiitteee e ettt e eetteeeeatbeeesaataeeestseaeaataeeeaassseeesasseaessteseeaassseeesabeeaeasseeeeanssseeeasseeasassseeeanssasesssbeeaeasseseessnnaesssreeann 21
PROGRAM SHUTDOWN — POWER OUTAGES — CHANGE PC ...ttt ettt ettt e ettt e e e s tae e e e eate e e e eaaae e e s areeaan 21
CHAPTER 5: USE OF THE BRIDGEMATE® PRO SCORING DEVICES ... ittt iteirieeitesesirsieseierssesseseeseeseesssessesseees 22
EXPLORING THE BRIDGEMATE . ... ceciititieiittteeiitieeeeatteeesitteeesaabeeeaateeeeaassesessabeeaaasteseeaassssesaasesaeasseseeaaseseeesssesaeabbeeeaasseseessenaessraeann 22
ACTIVATING THE BRIDGEMATE .....uttiie ittt e e ittee e ettt e eettee e s stteeaeatteeeaatseeessabeeaaasteseeaassseessabesaeasteseeaaseseessabesaeasteeeesassaeesasbesaessseeeeanes 23
ENTERING RESULTS WITH THE BRIDGEMATE .....iitte ittt iiteesteeiteestteesteessteesseessteesaseesssesasseesssesasseesssesssseesssesssssesssessssessssessssnessnees 24
POSTING BRIDGEMATE PRO RESULTS .. uttiitteittteiteestteeiseessteesseesssessssesssessssssssessssesssessssesssesssssssssssssesssesssssesssessssessssessssssssees 28
L 201 = PSPPSRI 28
CHAPTER 6: ADDITIONAL BRIDGEMATE FUNCT IONS ... 1ottt eieisiesseessssieeeesssesiessaasseeisssasssseisssanseesens 30
READING RESULTS MANUALLY IN BRIDGEMATE ....eeittiiiteeiteeiteestteesteessteesteessseesssaesssesssseesssesssssesssessssessssesssssesssessssessssessssesssnees 30
BRIDGEMATE SETTINGS ..teeiuttiiteeitteeiteessteeaseessseesseesssesaseesssesssseesssessssesssessssssssesssssesssesssseesssssssssessssesseessseessssessseesssessseessssessees 30
UPDATE SETTINGS DURING PLAY ... utitieittte e e itteeeeateeeesetteeesetteeeaasteseesassseessabeeeaasteseeaassssesasbesaeanseeeesassseeeassasaeabeeseaasseseessaeaessreeann 31
SYSTEM FUNCTIONS .. uttiteiitteee e ettt e e eetteeesetbeeeaattaeeesbseeeaabaeeeaassseeesssseaeasteeeeaassseeesabesaeasteeeeasssseeasbeeaeassseeeanssaeesssbeeeeanseeeessseeessrenann 31
REAL-TIME PUBLICATION ...utiiiiittiieietit e e eitiee e e ettt e e ateeeesatteeesatbeeeaaateeeeaasseeessabeeaeasteeeeaassseeesasesaeanseeeeaaseseeesssesaesbbeseaasseeeessenaessrenann 32
CHAPTER 7 TIPS FOR USE ... tiiiitiii ittt ittt ittt sttt e e it e ettt e e eeteee it seaesses it seesseetseeesseetseebsee s seesse et seesseebseesseebbsssseesseareeasres 33
REPLACING BRIDGEMATE ....eeiiiittiteietieee ittt e s itteeeaateeeesatseessasbesaaateseesasssesssabesaaasteseeaassssessasesaeasseeeeaasesseesssesaesbbeeeaasseeeesseeaesssreeann 33
RECOVERING THE SERVER......cuttiitttiiteeiteeiteesteessteesstesaseessseessseesssesssssesssesssessssesssssesssesssssesssessssessssessseesssesssseesssessssesssseessseesnees 33
PROCEDURE IN THE EVENT OF DATA LOSS ...uteittttiteeiteeiiteessteesseessteesseessseessessssessssssssesssssesssesssssssssssssessssessssssssessssessssesssssssssees 33
MULTIPLE BRIDGE CLUBS PLAYING SIMULTANEOUSLY ..1eittteititeitteeitreesteeeitrsesseesssssasseesssssassssssssssssesssssssssesssssssnsessssessssessnsessnsesans 34
LARGE TOURNAMENTS. ... ttttettteitteeitteesteeestseesteeessseeasasestssessesessssansessssssansessssssessessssssansessssssansesssssssnssssssessnsessssessnsessnsessnsessnsessnsenans 35
USING ACBLSCORE AND BRIDGEMATES ON A NETWORK .....ccttiiiieiieeiieesiteesiteesteessteesseesssesssseesssesssseesssesssseesssessssessssessssesssnees 35
CHAPTER 8: USING BRIDGEMATES WITH ACBLSCORE ...ttt s i sesnsssiessessseessrsesseseisesesssesees 36
IN ST ALLATION. ...ttt e ittt e e iteee e ettt e e e ettt e e stbeeeeseteeeeaasseeeasabeeaeastaeeeaassseeesaaeeaesasseeeaseeseeaaseeeeasseeeeanseseeeaasaeaesatbeeeastseeeasseeaeantbeeesasseeesansees 36
SOFTWARE REQUIRED ..tttiiiiiiiiiitttiiit i e s s s siittbett s e e e s s ibbbatteesesssasbbstaeeseessasbbebeesseessasabebe e e saeesesabbbaaeseeesssab bbb aeeeseesss bbb besesesssasbbbbaneseessasanres 36
INSTALL SOFTWARE .....ceiiiutteeeitteeeeetteeeestbeeeestteeeeaasteeeasabesaeastaeeeaasssseesaseeaesstseeeassseesaabeeaeasseseeasssseeassaeaesasbeeeastseeeasseeaeassbeeesasseeesannns 36
CONNECT THE BRIDGEMATE SERVER TO THE COMPUTER. .....eciititiiitttee ittt e eitteeessteeaesteeeesaasseesssbeeasassseessassssesssbeeeaassssessnsseeessssenans 36
S O T] =  U = S SO TP RO PPRRPI 36
AACBLSCORE SETUP ....uttiiiittiie ettt e e ettt e e ettt e e s sttt e e e ataeeeaaseeeessabeeaaasteeeeasseeessabesaeasteseeaseseesaabeeeaasteeeeanseseesaabeeaeasteeeeasseeesssbeeasasseeeeanns 37
READ DATA FROM THE BRIDGEMATE SCORING SYSTEM INTO ACBLSCORE........ccceiitiiiteeiie e seeeste e steestve e sreesnve e snneesaveesnaeesnne s 39
PLAYER NUMBERS ...ttt itteittetiteesteesiteestteesteesstesssseesstesasseesssesasseessseessseessseeassesssseessseesssesasseesssesssssessseessseessssessesesssesssseessseesssnessnees 39
[T 2y B =] T PSSR 39
(O 10T Tt T =i U I 1= R STSR 40
CHANGE MOVEMENT AFTER GAME HAS STARTED ......tttittteeitteeitteeitteesteeesteeasseesssssasssssssssassesssssesnssssssssensessssssanessssssesesssssssnessnnes 40
CHANGE BEFORE ANY BRIDGEMATES HAVE BEEN USED ....cvvietveeitteeitteeiteeesteeesseeestssessessssssassesssssssssessssssensessssssensessssssessesssssssnsessnnes 41
CHANGE AFTER PEOPLE HAVE STARTED MEMBER NUMBER AND/OR SCORE ENTRY .....cutiitiieitieeitieeiteeeiteeesseessteeesseessseessseesssessssesssnns 41
REPLACING BRIDGEMATE DURING PLAY ...oiiiiittiieiiitieeeiitteeeseteeeaatteeesasteesssateeaaateseeaassssessssesaaatseeesassssesssesaesasbeseaasssseesasseeesssreeans 41
SWISS TEAMS AND KINOCKOUTS.....iiiitiieeiittiee e ettt e e etee e e e ette e e e etteeeesabeeee s tbeaesassseeasabeeaeastaeeeassssesasbeeaeassseeesssasesabbeeeeasteeesasseeessrenann 42
PROCEDURES WHEN USING PLAYER ENTRY OF SECTION/TABLE ......cctitittiiiteeite e iite e sttt steesate s stteesttessateestbessasessatesssseesanessnneesanens 42
SPE C AL REPORTS. .. ttiiiittit ettt et ettt e e oottt e e e ettt e e e ettt e e sbeeeesabbeeeaastaeeeaabeaaeastbeeeaasseeeesabeeaeasteeeeanssseesasbeeaeastseeeanseeeeeaabeeeeasteeeeaseeeessreeann 42
EXPANDED DETAIL AVAILABLE ON VWEBSITES. ...iitteitteiitteiteeiteestteesseessreessessssesssssesssesssssssssesssssssssesssssesssessssesssesssssssssessssessnees 43
USING BRIDGEMATES |1 AND BRIDGEMATES PRO TOGETHER ....ccuvtiiiteeitteiteestteesteesateesteessneessseessnesssseesssesssssssssessssesssnessssessnes 43

DECLARATION OF CONFORMITY ..ottt 44




Limited Warranty 1

Limited Warranty

IMPORTANT—PLEASE READ THIS LIMITED WARRANTY CAREFULLY TO UNDERSTAND YOUR RIGHTS AND
OBLIGATIONS! The term “Hardware Device” means the Bridge Systems hardware product. The term “You” means
either an individual or a single legal entity who will be referred to in this Limited Warranty as “You” and “Your”.

A. WARRANTIES.

1. Express Warranty. Subject to the terms and conditions of this Limited Warranty and in lieu of any other (if any)
express warranties, Bridge Systems warrants that under normal use and service, on the date of acquisition as shown
on Your receipt or similar proof of payment and for the period of time stated below for the applicable Hardware
Device (hereafter each defined as the “Warranty Period”), that the Hardware Device will substantially conform with
the accompanying Bridge Systems packaging and documentation. As to any defects discovered after the Warranty
Period, there is no warranty or condition of any kind.

Warranty Period:
For all new hardware parts of the Bridgemate Scoring System: two (2) years; refurbished equipment is one (1) year.

This Limited Warranty does not cover, and no warranty of any kind is provided with respect to any subjective or
aesthetic aspects of the Hardware Device. The express warranty stated above is the only express warranty made to
You and is provided in lieu of all other express or implied warranties and conditions (except for any nondisclaimable
implied warranties that exist), including any created by any other documentation or packaging. No information or
suggestions (oral or in a record) given by Bridge Systems, its distributors, agents, affiliates or suppliers or its or their
employees or agents, shall create a warranty or condition or expand the scope of this Limited Warranty.

2. Limitation on Duration of Implied Warranties. If You are a consumer, You may also have an implied warranty
and/or condition under the laws of some jurisdictions, which is hereby limited to the duration of the Warranty Period.
Some jurisdictions do not allow limitations on how long an implied warranty or condition lasts, so the foregoing
limitation may not apply to You.

B. EXCLUSIVE REMEDY. Subject to applicable law and the following, and provided that You return the Hardware
Device to Your place of acquisition (or, if that place will not accept the return, to Bridge Systems) with a copy of Your
receipt or other bona fide proof of payment during the Warranty Period, Bridge Systems will, at its option and as Your
exclusive remedy for breach of this Limited Warranty and any implied warranties:

repair or replace the defective Hardware Device; or make payment to You for the allowable damages that You
incurred in reasonable reliance, but only up to the amount You paid (if any) for the Hardware Device less reasonable
depreciation based on actual use.

The above remedy is subject to the following:

Any repaired or replaced Hardware Device will be new or refurbished or serviceably used, comparable in function
and performance to the original Hardware Device, and may include third party items;

Any Hardware Device repaired or replaced under this Limited Warranty will be warranted for the remainder of the
original Warranty Period or 30 days from the date of shipment of the item back to You, whichever is longer.

Except as otherwise required by legislation in Your jurisdiction, costs associated with transport (including packaging)
for warranty service shall be at Your expense; and Bridge Systems, its distributors, agents, affiliates and suppliers do
not provide any warranties regarding any other services provided under this Limited Warranty and disclaim all duties
(if any) of workmanlike effort or of lack of negligence regarding such services.

C. NO OTHER WARRANTIES. The express warranty stated above is the only express warranty made to You and is
provided in lieu of all other express or implied warranties and conditions (if any) including any created by any other
documentation or packaging. No other warranties or conditions are made with respect to the Hardware Device or the
warranty services by any person, including but not limited to Bridge Systems, its distributors, agents, affiliates and
suppliers. No information (oral or written) or suggestions given by Bridge Systems, its distributors, agents or
suppliers or its or their employees, shall create a warranty or condition or expand the scope of this Limited Warranty.
Also, there is no warranty or condition of title, quiet enjoyment, or noninfringement in the Hardware Device. You may
have greater rights existing under legislation in Your jurisdiction.



2 Limited Warranty

D. EXCLUSION OF OTHER DAMAGES.

TO THE FULL EXTENT ALLOWED BY LAW, BRIDGE SYSTEMS AND ITS DISTRIBUTORS, AGENTS,
AFFILIATES AND SUPPLIERS ARE NOT LIABLE FOR ANY:

(i) CONSEQUENTIAL OR INCIDENTAL DAMAGES;

(i) DAMAGES OR LOSS OF ANY NATURE WHATSOEVER RELATING TO LOST PROFITS, BUSINESS
INTERRUPTION, LOSS OF DATA OR PRIVACY OR CONFIDENTIALITY, ANY INABILITY TO USE ALL OR PART
OF THE HARDWARE DEVICE, PERSONAL INJURY, OR ANY FAILURE TO MEET ANY DUTY (INCLUDING BUT
NOT LIMITED TO ANY DUTY OF NEGLIGENCE, GOOD FAITH OR OF WORKMANLIKE EFFORT); OR

(iii) INDIRECT, SPECIAL, OR PUNITIVE DAMAGES ARISING OUT OF OR RELATING IN ANY WAY TO THE
HARDWARE DEVICE. THE FOREGOING APPLIES EVEN IF BRIDGE SYSTEMS OR ANY DISTRIBUTOR,
AGENT, AFFILIATE OR SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH LOSSES OR
DAMAGES; AND EVEN IN THE EVENT OF FAULT, TORT (INCLUDING NEGLIGENCE), STRICT OR PRODUCT
LIABILITY, MISREPRESENTATION OR OTHER REASON.

Some jurisdictions do not allow the exclusion or limitation of incidental or consequential damages, so the above
limitation or exclusions may not apply to You.

E. EXCLUSIONS FROM COVERAGE. This Limited Warranty shall not apply and Bridge Systems, its distributors,

agents, affiliates and suppliers have no liability under this Limited Warranty if the Hardware Device:

- is used for commercial purposes (including rental or lease);

- is modified or tampered with;

- is damaged by Acts of God, power surge, misuse, abuse, negligence, accident, wear and tear, mishandling,
misapplication, or other causes unrelated to defects in the Hardware Device;

- is damaged by programs, data, viruses, or files, or during shipments;

- is not used in accordance with the accompanying documentation and use instructions; or

- is repaired, modified or altered by other than a Bridge Systems authorized repair center and the unauthorized
center causes or contributes to any defect or damage.

F. REGISTRATION. You need not register Your acquisition of the Hardware Device for the Limited Warranty to be
effective.

G. BENEFICIARY. To the extent allowed by applicable law, the Limited Warranty is only made to You, the first
purchaser of the Hardware Device, and there are no third party beneficiaries of the Limited Warranty. It is not
intended for and does not apply to anyone else (except as required by law), including anyone to whom You make
any transfer of the Hardware Device.

H. FURTHER INFORMATION. Bridge Systems is the warrantor under this Limited Warranty. To receive
instructions for obtaining performance of this Limited Warranty You must either contact the local Bridgemate
distributor serving Your country, or write to: Bridge Systems BV, Postal Box 21570, Rotterdam, 3001 AN, The
Netherlands, or visit Bridge Systems on the World Wide Web at http://www.bridgemate.com.

You must also:

1. Submit proof of payment in the form of a bona fide, dated receipt, or invoice (or a copy) evidencing that You are
the beneficiary of this Limited Warranty and that Your request for a remedy is made within the Warranty Period;

2. Follow Bridge Systems’ shipping and other instructions if it determines that all or part of Your Hardware Device
requires return. To obtain the Limited Warranty performance, You must take or deliver the item in either its original
packaging or packaging that provides an equal degree of protection to the location specified by Bridge Systems.
Except as otherwise required by legislation in Your jurisdiction, costs associated with transport (including packaging)
for warranty service shall be at Your expense. Failure to follow the above instructions may result in delays, cause
You to incur additional charges, or may void Your warranty.

This Limited Warranty gives You specific legal rights and You may also have other rights which vary from jurisdiction
to jurisdiction. Where any term of this Limited Warranty is prohibited by such laws, it shall be null and void, but the
remainder of the Limited Warranty shall remain in full force and effect if its allocation of risks is not materially
disturbed.
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Safety Instructions

Important safety warning

Failure to properly set up, use, and care for the Bridgemate system can increase the risk of serious injury or death, or
damage to the system. Read this manual and the manuals of any peripherals for important safety and health
information. Keep all manuals for future reference. For replacement manuals, go to
www.bridgemate.us/media/downloads/user-manual-pro.pdf or contact Bridgemate.US.

Select a safe location for the Bridgemate server and scoring devices

If the Bridgemate Pro server or Bridgemate Pro scoring devices falls and hits someone, it could cause serious injury.
To reduce the risk of such injuries and damage to parts of the system, set them up according to these instructions
and place them on a surface that:

Is flat and level.

Is stable and not likely to tip over.

Allows all four feet of both the server and scoring device to be in contact with the surface.

Is not likely to allow the server and scoring device to slip or slide off.

Is clean and free of dust and debiris.

If the surface or feet of server or scoring devices become dirty or dusty, clean them with a dry cloth.

Arrange all cables and cords so that people and pets are not likely to trip over or accidentally pull on them as they
move around or walk through the area. When the Bridgemate server is not in use, you may need to disconnect all
cables and cords from the server to keep them out of the reach of children and pets. Do not allow children to play
with cables and cords.

Do not place any part of the Bridgemate system on a bed, sofa, or other soft surface. Do not place any part near
heat sources, such as radiators, heat registers, stoves, or amplifiers.

Avoid smoke and dust
Do not use the Bridgemate Scoring system in smoky or dusty locations. Smoke and dust may damage the
Bridgemate server and scoring devices.

Connect the Bridgemate server to power

WARNING As with many other electrical devices, failure to take the following precautions can result in serious
injury or death from electric shock or fire or damage to the Bridgemate Pro system.

Select an appropriate power source for your Bridgemate server:

e Use only the power adapter that came with the Bridgemate server or that you received from your Bridgemate
supplier. If you are not sure if you have the correct power adapter, stop using it and contact Bridgemate.US.
If you need a replacement power adapter, contact Bridgemate.US as well.

e Confirm that your electrical outlet provides the type of power indicated on the power adapter (in terms of
voltage [V] and frequency [Hz]).

e Do not use non-standard power sources, such as generators or inverters, even if the voltage and frequency
appear acceptable. Only use AC power provided by a standard wall outlet.

e Do not overload your wall outlet, extension cord, power strip, or other electrical receptacle. Confirm that they
are rated to handle the total current (in amps [A]) indicated on the power adapter and any other devices that
are on the same circuit.

To avoid damaging the power cord and power supply:
e Do not wrap the power cord around the power adapter.
e Protect the power cord from being walked on.
e Protect cords from being pinched or sharply bent, particularly where they connect to the power outlet, the
power adapter, and the Bridgemate Pro server.
e Do not jerk, knot, sharply bend, or otherwise abuse the power cord.
e Do not expose the power cord to sources of heat.


http://www.bridgemate.us/media/downloads/user-manual-pro.pdf

4 Safety Instructions

e Keep children and pets away from the power cord. Do not allow them to bite or chew on it.
e When disconnecting the power cord, pull on the plug—do not pull on the cord.
e Do not let the power supply hang from the power cord.

If a power cord or power supply becomes damaged in any way, stop using it immediately and contact your
Bridgemate supplier. Only use the power supply and AC power cords supplied with your Bridgemate Scoring System
or received from your Bridgemate supplier.

Unplug the Bridgemate server during lightning storms or when unused for long periods of time.

Always connect the power cord according to the following instructions:
1. Fully insert the power supply cord into the Bridgemate Pro server.
2. Plug the power adapter into the wall outlet.

Insert batteries into the Bridgemate Pro scoring devices or server

WARNING Improper use of batteries may result in battery fluid leakage, overheating, or explosion. Released
battery fluid is corrosive and may be toxic. It can cause skin and eye burns, and is harmful if
swallowed. To reduce the risk of injury:

Keep batteries out of reach of children.

Do not heat, open, puncture, mutilate, or dispose of batteries in fire.

Do not mix new and old batteries or batteries of different types (e.g., carbon-zinc and alkaline batteries)

Remove the batteries if they are worn out or before storing your Bridgemate Pro system for an extended

period of time. When removing batteries from the Bridgemate or server do not use your fingers or finger nails

to remove the batteries; use a blunt object like a screwdriver or pen to safely remove the batteries.

e If a battery leaks, remove all batteries, taking care to keep the leaked fluid from touching your skin or clothes.
If fluid from the battery comes into contact with skin or clothes, flush skin with water immediately. Before
inserting new batteries, thoroughly clean the battery compartment with a damp paper towel, or follow the
battery manufacturer's recommendations for cleanup.

e Dispose of batteries in accordance with Local and National Disposal Regulations, including those governing
the recovery and recycling of waste electrical and electronic equipment (WEEE).

Remove batteries aboard aircraft

Before boarding any aircraft or packing the Bridgemate scoring devices or server in luggage that will be checked,
remove all batteries. The Bridgemate server and scoring devices can transmit radio frequency (RF) energy, much
like a cellular telephone, whenever batteries are installed.

Do Not Attempt Repairs

Do not attempt to take apart, service, or modify the Bridgemate server, Bridgemate Pro scoring devices, power
supply, or its peripherals in any way. Doing so could present the risk of serious injury or death from electric shock or
fire, and it will void your warranty.

Any evidence of any attempt to open and/or modify the Bridgemate Pro system, including any peeling, puncturing, or
removal of any of the labels, will void the Limited Warranty and render the Bridgemate Pro system ineligible for
authorized repair.

Disposal of Waste Electrical and Electronic Equipment in the European
Union and other countries/regions with separate collections systems

This symbol on the product or its packaging means that this product must not be disposed of with

household waste. Instead, it is your responsibility to hand this over to an applicable collection point

for the recycling of electrical and electronic equipment. This separate collection and recycling will [
help to conserve natural resources and prevent potential negative consequences for human health

and the environment, which inappropriate disposal could cause due to the possible presence of hazardous
substances in electrical and electronic equipment. For more information about where to drop off electrical and
electronic waste, contact your local city/municipality office, your household waste disposal service, or the shop where
you purchased this product.
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Introduction

Thank you for purchasing your Bridgemate® Il scoring system. Bridgemate Il is an advanced electronic scoring
system for bridge clubs and tournaments, designed to enhance the enjoyment of bridge. Bridgemate Il automatically
registers board results. The scores are verified and fed to the central PC. Tournament directors will value the user-
friendly features of Bridgemate I, as it enables them to focus fully on their core tasks.

This manual describes the operation of the Bridgemate Scoring system, including the central software program, the
server and the Bridgemate scoring devices. This manual serves as an addition to the manual supplied with your
scoring program. As the Bridgemate Scoring system operates independently from the scoring program, this manual
includes instructions for operating ACBLscore — but not other scoring programs.

This manual consists of the following chapters:

e The components of the Bridgemate Scoring system are explained in Chapter 1. A brief and concise
explanation is given of the individual components and how they relate to each other.

e Chapter 2 explains how to configure and install the Bridgemate Il software and hardware and how to
configure the Bridgemates per section and table. This chapter also explains how to set the radio channels to
enable wireless data exchange.

e Chapter 3 explores the use of the Bridgemate Control Software in more detail.

e Chapter 4 explains the different Bridgemate Control Software options offered by the Bridgemate Il server.

e Use of the Bridgemate Il scoring devices is explained in Chapter 5.

e Chapter 6 highlights the additional functions for the Bridgemate.

e Chapter 7 contains tips on how to operate the Bridgemate Il scoring system when multiple bridge clubs are
playing simultaneously in one room. Practical advice is also offered on how to deploy Bridgemate Il in big
tournaments, involving different rooms and/or multiple servers.

e Chapter 8 describes using the Bridgemate system with ACBLscore.

Version numbers

This manual covers the following versions of the Bridgemate Pro components:

Bridgemate Control Software 3.4.4 BCSsetup3-4-4.exe (See note - below)
Bridgemate Pro “serial’ server 1.2.6 (firmware version) serv126.exe

Bridgemate Pro scoring devices 2.3.2a (firmware version) US232a.bpf

Bridgemate RF Protocol 1.3 (firmware version) rfmodem13.bpf

Note: For new installations use BCSsetup 3.6.10 or 3.7.19 — available on www.bridgemate.us — see Support >
Answers/Download - Bridgemate Software - BCS Software/Firmware Compatibility.

Download Software and Firmware

Bridgemate software and firmware as well as installation instructions may be downloaded from www.bridgemate.us

Notes:

Bridgemate Control Software (BCS) 3.1.2 and later versions are compatible with Windows 10.

Windows .NET framework 4.0 (or later) is required to install v3.2.1. If Windows .NET framework software is required
on your computer, BCSsetup3-2-6 and later will automatically install it. The Microsoft .NET framework files are
available at:

e Windows XP:
https://www.microsoft.com/en-us/download/details.aspx?id=17851

e Windows Vista SP2, Windows 7 SP1, Windows 8/8.1, Windows 10
https://www.microsoft.com/en-us/download/details.aspx?id=42642



http://www.bridgemate.com/resources/program/BCSsetup3-6-10.exe
http://www.bridgemate.com/resources/program/BCSsetup3-7-19.exe
http://www.bridgemate.us/
http://www.bridgemate.us/media/downloads/compatibility-chart.pdf
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https://www.microsoft.com/en-us/download/details.aspx?id=17851
https://www.microsoft.com/en-us/download/details.aspx?id=42642

6 Chapter 1: Description Bridgemate Pro scoring system

Chapter 1: Description Bridgemate Scoring System

This chapter describes the components of the Bridgemate Scoring S ystem and how they relate to each other. It also
explains how to use the Bridgemate System - from creating a session in your scoring program to registering the
scores in the scoring program.

Please read this chapter carefully. Once you understand the function of the individual components and how they
relate to each other, you will quickly get to grips with the Bridgemate Scoring System.

Description of components

The Bridgemate Scoring System consists of the following hardware and software:

e Bridgemate Pro scoring devices e Bridgemate server + power adapter
e USB-to-serial converter (dongle) e Bridgemate communication cable
e Tournament directors key e Bridgemate Control Software
‘«\\- Bridgemate server + power adapter USB-to-Serial converter,
“dongle”
Bridgemate Pro
scoring device
“Bridgemate” ﬁ
©,
Tournament
directors key
Bridgemate communication cable “TD Key”

Bridgemate Pro scoring devices

The Bridgemate Pro scoring devices are placed on the bridge table and are used to enter the results. For the
purpose of simplicity, we shall refer to these input devices as "Bridgemates”. Wireless communication between the
Bridgemates and the server is established and maintained using radio frequency waves. Only one Bridgemate is
required per table. The use of the Bridgemates is explained in more detail in Chapter 5.

Bridgemate server

The Bridgemate server, “server” for short, is a small device connected to the PC. It acts as a bridge between the PC
and the Bridgemates Pro. As the PC cannot communicate directly with the Bridgemates, the server is a vital
component. The server is equipped with a radio transmitter and a receiver, establishing and maintaining wireless
data communication with the Bridgemates. The server sends all movement data to the Bridgemates, including board
numbers and pair numbers, and receives the board results in return. The server can control up to 128 Bridgemates
simultaneously. The server can be powered by either an external power adapter or by 4 AA Batteries.

USB-to-serial converter (dongle)

The server is connected to the serial port of your PC. If your PC does not have a serial port, use the USB-to-serial
converter, included with the Bridgemate server. To add a serial port to your PC, connect the converter to a USB port
on your PC. Itis recommended the same USB port be used every time. Do not use a USB hub.

Bridgemate communication cable

The Bridgemate communication cable enables you to connect the Bridgemate scoring devices directly to the PC.
This in turn enables you to read the board results stored in the Bridgemate memory manually, or to install new
firmware in the Bridgemates.

Tournament directors key (TD Key)
The tournament directors key, TD-key for short, is a small key that enables the tournament director to configure the
Bridgemate for each section and table, and to activate the special TD menu.
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Bridgemate Control Software

A specific program is required to control the server from the PC: Bridgemate Control Software (BCS). This program
runs on Windows XP or higher and is controlled in part by your scoring program. BCS fully controls the server and
data exchange between the server and the PC. BCS first saves all the relevant session data used by the server to
control the Bridgemates. BCS then retrieves all entered board results from the server and stores these in the result
(.bws) file. All other server controls are also executed from BCS.

In addition, the following three components are important. Although they are not supplied together with your
Bridgemate Scoring System, they are of crucial importance to the correct operation of the system.

e Client (=Personal computer with Bridgemate Control Software)

e Result (.bws) file

e Scoring program

Client

Bridgemate Control Software runs on a so-called “client” (Windows-based) personal computer (PC). The scoring
program and BCS usually run on one client PC, to which the server is also connected. During big tournaments,
multiple servers may be required to support the high number of Bridgemates and/or to establish and maintain the
wireless communication between the server and the Bridgemates. In this case, the servers are connected to a
network PC, and the network consists of multiple clients.

Note: The term “client” suggests that the Bridgemate Scoring System also consists of a PC network server. This is
not the case. All (network) PCs running the Bridgemate Control Software are known as clients.

Result (.bws) file

The result (.bws) file is created by the scoring program. It contains all the session data, including sections, tables,
movements, etc. This data is generated by the session configured in the scoring program. BCS reads this session
data and feeds the correct data to the server. During the session, BCS reads all the board results entered in the
server and saves these in the result (.bws) file. All Bridgemate result (.bws) files have the file extension .bws.

Scoring program

The scoring program creates the session and calculates the scores. After you have created a session, the scoring
program will create the abovementioned result (.bws) file. This file contains all the relevant session data. The
scoring program will read all board results saved in the result (.bws) file and process these during the session.
These procedures are explained in more detail in the user manuals or help files of your scoring program.

Procedure

Having examined the individual components of the Bridgemate Scoring System, the next step involves assessing the
entire process and how the different components relate to each other.

The process is outlined in the below diagram:

Activity Explanation
Step 1: Session created in the This is the starting point in the process. In the session, users can set the number of
scoring program sections to be played, the number of pairs per section, boards and movements.

Step 2: Result (.bws) file created by Using the session data, the scoring program creates a result (.bws) file, containing
the scoring program all data relating to the sections, corresponding movements, boards and pairs.

The scoring program starts BCS. The result (.bws) file is then read by BCS,

Step 3: Bridgemate Control Software g | .
generating the data for all tables used in each session.

reads the result (.bws) file

BCS initializes the server using the data contained in the result (.bws) file. All
session tables are stored in the server. Movements from each table are included, so
that the server knows (per round) which pairs and boards correspond with which
table.

Step 4: Bridgemate Control Software
transfers data to the server
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Step 5: The server has been
activated and the Bridgemates can
be activated

Step 6: Results are entered in the
Bridgemate and sent to the server

Step 7: Bridgemate Control Software
retrieves the data from the server.
The information is saved in the
result (.bws) file

Step 8: The scoring program reads
the results saved in the result (.bws)
file and adds these to the session

Now that all the relevant data has been stored in the server, the Bridgemates can be
activated. The players activate the Bridgemates, which log in to the server. The
results can now be entered.

During this process, the board number and pair number/direction of play are verified
for accuracy. Verification is executed via direct communication between the
Bridgemate and the server. The Bridgemate itself does not contain any movement
data. Entered board results are sent directly to the server. This data is stored in the
server memory.

BCS reads all newly entered results from the server and saves them in the result
(-bws) file.

The scoring program reads the data saved in the result (.bws) file and stores these in
its session file. The results are processed and incorporated into the session data to
calculate the final score.

Automatic launch from your scoring program

If your scoring program fully supports Bridgemate, BCS can execute steps 2 to 4 and read the data (step 7)
automatically via one simple command from the scoring program. For further information on how to enable
automatic launch of the Bridgemate Scoring System, please contact the supplier of your scoring program.

Bridgemate app

The Bridgemate® App is a personal add-on to the existing Bridgemate Pro or Bridgemate Il Scoring System. By
using the app, during or after the game, players can consult their guide card for the next round settings, review their
scores, view current ranking or see their competitor’s scores as well as hand records for the boards already played.

The app also offers an interactive analysis tool to provide instructing feedback on your play.

e Guide card

e Personal Score Sheet
e Rankings

e Opponent’s scores

e Hand Records

e Analysis of your game

More information will be available on the www.bridgemate.us website.
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Chapter 2: Hardware Configuration

System requirements
Operating system

The Bridgemate Scoring System needs Windows XP SP3 or higher. Microsoft .Net 4 framework must also be
installed. [See Notes — page 4)

Hardware Recommended configuration:  Processor Celeron 1.6GHz or higher
Memory 1 GB or higher

Installing Bridgemate Control Software (BCS)
To install the Bridgemate Scoring System, run the current “BCSsetup.exe” file. This software is on the Flash
Drive/Memory Stick from Bridgemate.US; also, it may be downloaded from Bridgemate.US’s website
www....BCSsetup3-3-2.exe. The requirements for installing BCS software may differ, depending on your scoring
program. For more information about where to install the software on your PC, please consult the information
supplied with your scoring program. To install BCS on a separate client, we recommend the default folder
[C:\Program Files\Bridgemate Pro or C:\Program Files (x86)\Bridgemate Pro].
Special Note for Vista, Windows 7, 8 or 10 PC’s: Since Windows 7, 8, 10 and Vista's security precautions inhibit
writing to any file to the C:\Program Files folder or the “root” C:\,, previous instructions were to configure BCS to save
the Bridgemate Log File elsewhere, e.g., CAACBLSCOR. Starting with version 3.1.2 — the default location for the
Log file is the “User Appdata folder,” therefore, new installations need not change the Log files defaul location.

See File locations on Page 19 for specific details.

See Chapter 8 for information on using ACBLscore as your scoring program.

Installing the server

Power supply

To operate the server, please ensure it is connected to the power adapter or is fitted with batteries. The server
cannot operate without a power adapter and/or batteries. If batteries are not installed in the server and AC power is
lost, any unsaved data in the server will be lost!

Read the safety instructions at the front of this manual before installing the server.

Power adapter

A 9~12V power adapter is supplied with the server. Plug the adapter into the wall socket and the into the black
connector on the top of the server. The green LED on the server will light up, indicating that the server is now
connected to commercial power.

Batteries

Batteries are used if there is no commercial power source, or as a back-up in the event of power failure. The battery
compartment on the bottom of the server holds four AA 1.5 volt batteries (included). Install the four batteries as
indicated. A red LED will light up, indicating that the batteries have been installed correctly and no power adapter is
being used. The approximate operating time of the batteries is 50 hours.

Warning

e Always install the batteries as indicated. Incorrectly installed batteries could damage the server and the
batteries. The batteries may start leaking, potentially damaging the server and voiding the warranty.

e With batteries installed (but also when powered by power adapter) the server is always actively waiting to
receive a radio signal from a Bridgemate — even if the client PC is not running BCS. If a battery is not
removed, and the server is running on batteries only, the battery set will drain in aproximately 50 hours.

e When removing batteries from the Bridgemate scoring device or server do not use your fingers or finger nails
to remove the batteries; use a blunt object like a screwdriver or pen to safely remove the batteries.

When both the power adapter and batteries are used, the server will obtain its power from the adapter. The batteries
will only be activated if the adapter is not supplying power (e.g., during a power cut). Power will immediately transfer
to the batteries and no data will be lost. We recommend installing batteries (as a back-up) while the server is in
operation. This will ensure no data is lost during the session.


http://www.bridgemate.com/resources/program/BCSsetup3-3-2.exe
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Switching on / off

The server will automatically switch on once the power adapter is connected or the batteries are installed. To switch
off the server, both power sources will need to be removed. It is recommended the power adapter and batteries be
removed after you have finished using the server. Only one of the four batteries needs to be removed. To remove
the batteries, please use a screwdriver or pen; do not attempt to remove them with your fingers.

Warning Do not reinstall the removed batteries in the opposite direction. Instead, store them separately.
Reinstalling batteries in the opposite direction will damage the server as well as the batteries and void the warranty.

Note: Servers (supplied since June 2008) have a battery-power on/off switch. With the power adapter disconnected,
ared LED indicates good batteries. Use the on/off switch to save battery power. When starting a new game, turn
the switch on (the “|” indicator) to confirm that the batteries are OK (red LED); then, connect the power adapter.

Connecting the server to the PC

Connect the server to the serial port of your PC. If your PC does not have a serial port available, use the USB-to-
serial converter which is supplied with the server and connect it to a USB port. This adds an extra serial port to the
PC. The converter comes with a set of software drivers which need to be installed separately. See the
documentation included with the converter for more information.

When using a USB-to-serial converter, please ensure the serial port has a port number between 1 and 20. If the
assigned COM port is 21 or higher, it will must be corrected manually in Device Settings of Windows Control Panel.

Special note when using the USB-to-serial converter.

It is recommended that the USB converter always be connected to the same USB port. On some computers
Windows® will not recognize the converter when it is connected to a different USB port.

There is an LED in the ATEN USB-to-serial converter housing that flashes when data is being transferred through the
cable. If this light does not flash, it may be an indication that the converter is connected to a USB port that is not
configured with the appropriate drivers — or the assigned COM port is 21 or higher.

Note: BCS will only work with a COM port — 1 through 20.
With the USB converter connected to your computer, check the Windows’ Device Manager for the COM port
assignment. Left click on or - RUN and enter the devmgmt.msc command.

The correct driver must be used for the ATEN USB-to-serial adapter. Driver version 3.1.0.0 is required with the
64-bit Windows 7 & and 64-bit Vista. All other operating systems — including 32-bit Vista and 32-bit Windows 7 — will
use version 2.0.2.1. Visit the Bridgemate.US website for specific information: 32-bit computers or 64-bit computers.

Do not use a USB HUB. The USB-to-serial converter will not work reliably through a USB hub

Setting the region

When BCS is started with a new server attached to the PC, you will be asked to select the correct region. Select
North America. To enable the server to transmit data to the Bridgemates over the correct radio frequency, you must
select the appropriate region. The region setting in the Bridgemates is controlled by the Bridgemate firmware. The
Bridgemate firmware must be for the same region as selected for the server. In other words, the server will be
unable to transmit data to the Bridgemates if the server's region differs from the Bridgemates' region firmware.

Setting the channel

The Bridgemate Scoring System can communicate over different radio channels. This enables users to install
multiple systems next to each other without causing interference (see also Chapter 6, “Multiple clubs”). To enable a
Bridgemate to communicate with the server, it must be set to the same channel as the server. The number of
channels at your disposal depends on the region in which you are playing. The default setting for the Bridgemate
and server is channel O for each region.


http://www.bridgemate.us/answers-support/aten-usb-driver-32-bit/
htthttp://www.bridgemate.us/answers-support/aten-usb-driver/
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Setting Bridgemate channel

The channel over which the Bridgemate Pro communicates is set using the same menu used for changing the
section/table settings. The tournament director (TD) key is used to perform this operation. See also Chapter 5 for
more information.

SECTION: A +/-

TABLE: 1

Set the section and the table first, and press OK. The following screen will appear:

CHANNEL: O

Press the CANCEL button to delete (erase) the set value and enter the new value. Press OK to save the new
settings.

Setting server channel

The channel over which the server communicates is set via Bridgemate Pro Control, Server = Channel selection
menu. For more information on how to set the channels, please see Chapter 4.

Configuring the Bridgemates

Before the Bridgemates can be used in the session, the section and table for each Bridgemate will need to be
configured. For more information on how to configure the Bridgemates, please see Chapter 5.

Operating instructions

The Bridgemate server is very easy to use. Only a few instructions need to be followed. The following rules must be
observed:

- The supplied power adapter may only be used with the Bridgemate server. Under no circumstances should
another adapter be used.

- Under no circumstances should the power adapter be connected to the data port of the Bridgemate (black
connector at the back) as this may cause damage to the Bridgemate hardware. This data port may only be
used with the Bridgemate communication cable and tournament director’s key.

- Under no circumstances should the Bridgemate communication cable and TD-key be connected to the
power adapter connection of the server.

- Install the batteries as indicated. Incorrectly installed batteries could damage the server.
- During use, make sure the server is placed horizontally on a level surface.

- Do not place any objects on the server and make sure there is as much distance between the server and
other objects as possible. The fewer objects there are between the Bridgemates and the server, the better
the data exchange will be.

- Where possible, make sure the Bridgemates and the server are not separated by a wall. The server should
preferably be placed in a central location between the Bridgemates. If this is not possible, place the server
as closely as possible to the Bridgemates along the edge of the playing room.

- When removing batteries from the server (or Bridgemates) do not use your fingers or finger nails to remove
the batteries; use a blunt object such as a screwdriver or pen to safely remove the batteries.
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Chapter 3. Bridgemate Control Software

The Bridgemate Control Software (BCS) program is the bridge between the result (.bws) file and the server. BCS
reads the session data from the result (.bws) file and loads it into the server so that the server can control the
Bridgemates. Then, BCS retrieves the entered board results from the server and stores these in the result (.bws) file.
BCS has been designed for simplicity and ease of use and is very user friendly.

This chapter contains information on the basic and advanced functions of BCS. For general program use, it is not
necessary to know all the information contained in this chapter. When first starting the system, be sure to read the
paragraphs “Launching Bridgemate Control”, “Logging in and logging off Bridgemates” and “Board results” first.

Launching Bridgemate Control

Bridgemate Control Software is launched from your scoring program. Depending on your scoring program, there are
several ways to launch BCS. The majority of scoring programs have a launching function, enabling fully automatic

activation of the Bridgemate server using the existing and active result =
(.bws) file. For more information, please consult the ACBLscore manual.

The BCS screen, as displayed here, shows a typical “mid-game”
condition where all Bridgemates are active and game results have been
entered for a number of boards.

The name of the active result file is displayed in the title bar. If no result
(.bws) file is open, the text “No session active” will show.

Server information

The pane in the top left-hand corner of the screen displays information

relating to the server. If a server has been found, the text “connected”

and the version number will be displayed. You can also check which e = ks
serial port is being used, and whether the server is running on a power adapter or batterles If the power adapter is
used, “AC mains adapter” will be displayed; if batteries are used, the power meter will display the number of
operating hours remaining in percentages. If you are using batteries, we would recommend replacing them
periodically rather than overusing them. BCS will indicate when to replace the batteries. Lastly, BCS will display the
Region and Channel being used.

Tables

The bottom left-hand corner of the screen lists the tables in the data (.bws) file as created by the scoring program. A
red or green dot indicates the status of the table. Red means that table’s Bridgemate hasn’t been activated yet, or
has finished the session. Green means the Bridgemate has been activated is currently in use.

Received board results

All board results read from the server are displayed in the right-hand side of the screen. For each hand/board
played, the table(s), pair numbers, declarer, contract, tricks made or set and the exact time the board result was
saved in the result (.bws) file are displayed. BCS logs the time/date when the server was read and the board result
was saved in the result (.bws) file. The system does not log the time/date when the hand was actually registered in
the server.

Board monitor and round monitor

To provide the director with up-to-date information on the progress of the session, a round and a board monitor are
available. The round monitor shows how many scores have been recorded for each table in each round. The
board monitor shows how many scores have been recorded at each board for each table. Both monitors are
updated in realtime when new results come in.

Result matrix
The result matrix shows the results conveniently arranged. A quick glance tells you which scores are recorded per
board or table. The matrix has different viewing orientations which can be controlled from the Options menu.

Players
This tab shows the member numbers as they are entered on the Bridgemates, and the names of the players — as
found in the local database (loaded from ACBLscore initially) or tournament database (pre loaded in BCS options).
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Filtering and sorting board results
The multi-criteria filtering and sorting functions are in the bottom right-hand of the screen. This enables fast searches
for specific boards or to compare results using Section, Table, Round, Board, Pair NS and Pair EW filter/sort options.

Suspicious contracts analysis
The analysis of suspicious contracts detects contracts that may be incorrectly entered on the Bridgemate based on
other contracts and/or makeable contract information.

Logging in and logging off Bridgemates
Logging in Bridgemate

Once the corresponding tables have been added to the server, Bridgemates can be activated.

Once the Bridgemate has been switched on, the start-up screen will display the text “Bridgemate Pro” followed by the
version number. Press OK to go to the section and table number screen. Press OK again to log the Bridgemate in
to the server. The flashing symbol in the top right-hand corner of the Bridgemate screen indicates that radio
communication is taking place. Once the Bridgemate has logged in, all first round data will be displayed. The red
symbol in the “Status” column of the table list will turn to green. This column also gives a clear overview of all
inactive Bridgemates: if the status column is still red, the table has not activated its Bridgemate.

In the following cases, the Bridgemate will not be logged in to the server, but instead the message “SYSTEM NOT
ACTIVATED YET” will be displayed and the Bridgemate is returned to the start-up screen:
- The Bridgemate Scoring system has not been started yet by the scoring program.
- The corresponding table has not been added to the server.
- The session of this table has finished, all the results have been registered for this table. In this case, the
Bridgemate will display the message “End of session”.
- Another Bridgemate with the same section/table number setting has already logged in to the server.
0 Check the BCS screen (lower left) and confirm the Section/Table is showing green (from another unit).
0 Right click on the table and “Remove from server.” Close the confirming report.
0 Right click (again) on the table and “Add to server.” Close the report .
o Immediately log in the desired Bridgemate as this Section/table.
0 The Bridgemate that logged on incorrectly will now not work and need to be reset using the TD Key.
- The server is outside the range of the Bridgemate and cannot communicate with the Bridgemate.
- The server and the Bridgemate are not communicating over the same channel.
- The region setting in BCS does not match the region setting of the Bridgemate firmware region.

Logging off Bridgemate

The “End of session” message is displayed on Bridgemates that have completed all rounds and sent all the results.
These Bridgemates are returned to the “Bridgemate Pro” start-up screen and are automatically logged off from the
server. The status column of this table will turn red again, indicating that the session has been completed on this
table. A clear overview is given of all the active tables. All Bridgemates with the green status display are still in use.

Bridgemates log off automatically at the end of the session; also there are two altnerative options to log off manually:
- Use the reset function in the TD menu (option 0). The Bridgemate is returned to the start-up screen and is
logged off from the server. See Chapter 5 for more information on how to reset the Bridgemates.
- Via menu Server = Show tables, Log off table(s). See Chapter 4 "Overview of tables.”

The latter function can be used if you need to use another Bridgemate for a specific reason but cannot log off via the
reset function. A Bridgemate needs to be logged off before it can be replaced. See Chapter 7 for more information.

Board results

Reading from the server

Once the Bridgemates have logged in, they will feed data to the server during the session. These results are first
saved in the server. As long as the server is connected, BCS retrieves data every second from the server and
automatically stores it in the result (.bws) file. This is an automatic process and indicated by the following message
in the status bar: “Status: retrieving data from server”.

If the server is disconnected for a while, all results not yet sent will be retrieved from the server, read and saved in
the result (.bws) file as soon as the server is reconnected. Delayed reading and processing of scores is therefore
possible. Itis advised, however, that the server is connected at all times during the session and BCS is running.
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Results — Round Monitor — Board Monitor — Result Matrix

Viewing results

Results that have been read and saved in the result (.bws) file are displayed in the right-hand table of BCS. Per
result, an overview is given of the corresponding table, the round, the team, the player declaring the game and the
contract. The registration time and date is also displayed in the result (.bws) file. Remarks are also displayed (“Not
played” = the Bridgemate indicates that the game has not been played, 40% / 60% = arbitral score entered in the
Bridgemate).

Go to the menu Tools - Show/hide columns to select the columns you would like to show or hide.

Applying filter or sort order

As more board results are added and displayed, it becomes more time-consuming and difficult to find or compare
specific results. Although you will generally use your scoring program to see the scores, you may wish to view the
registered data in BCS.

To display a specific grouping of board results, you can apply a filter to the entire list. This filter can be configured at
the bottom of the screen. Enter specific criteria per section, table, round and board number and NS/EW pair number.
It is possible to enter multiple criteria, for example section A, table 1, round 3. Per criterion, select the filtering
preference - equal to, not equal, equal or less, equal or greater, between - and enter the relevant values. Select
Apply filter to apply the filter. To remove the filter and display all board results, press Reset filter.

The sort function can be used to sort the (filtered) results according to various criteria. Select the criteria and choose
Ascending or Descending for each criteria. Select Apply sort to start sorting the results.

Round and Board Monitor

Use Round monitor to view the number of boards that have been reported from each table in play. This enables
Directors to identify slow players and visit the table, if necessary. Board monitor shows which boards have been
played at each table.

Result Matrix

The Result matrix shows the scores as a grid where the scores are outlined for each table and board. This provides
a quick way to locate/view a specific score. Go to Tools - Options > General (tab) to select the desired display.

The grid can be shown in four different formats:

e Boards horizontally, tables vertically Use for Mitchell movements — Typically 7+ tables

e Tables horizontally, boards vertically Use for Mitchell movements — Best for small games

e Boards horizontally, declarer vertically Use for Howell or Mitchell where every pair # is unique
e Declarer horizontally, boards vertically Use for Howell or Mitchell where every pair # is unique

Filker ] Sort Suspicious contracts |

Suspicious Contracts

. . [+ Contract declared by bath NS and By Iv Double dummy check. ¥ Automatically check re
Incomi ng contracts can be aUt_Om atlcal ly Contracts are suspicious when total ticks in NS Contracts are suspicious when tricks won
analyzed and marked as suspicious when | andEw exceeds: iz (e s Eieslkmars
the contract is suspected to be incorrect. Contracts in sui: L 4 iehes & et

In order to enable this analysis, go to the Contiacts in NT: 15
tab “Suspicious contracts” on the bottom of the screen:

Suspicious contracts can be analyzed using two different methods:

1. Comparing contracts in NS and EW: Contracts are compared with other contracts on that board. In case a
contract appears in the same suit or no trump in both the N-S and E-W direction, the contracts are marked
suspicious in case the total number of tricks won by N-S and E-W exceeds the specified number. The defaults
are 14 for both suit and NT contracts. You will probably wish to change the numbers; particularly since INT by
NS and 1 NT by EW (total of 14 tricks) are often encountered.

Example 1: Total tricks for NT contracts is set to 14. 3NT N = 3 and INTx W -2 will be marked as
suspicious as the total number of tricks is 14 and this does exceed the threshold value.
Example 2: Total tricks for suit contracts is setto 14. 3H S =4 and 2H E = 3 is — in total — 19 tricks and
therefore will be marked as suspicious.
When only one contract is registered in a direction, this contract is marked as suspicious.
When there are two or more contracts in both directions, all contracts are marked as suspicious.

2. Compare contracts against double dummy (makeable contract information). This check requires hand records

to be available to the Bridgemate system. Hand records can be imported into BCS. Each contract is
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compared with the makeable contract information and when the total number of tricks deviates from the
double-dummy analysis by the specified number of tricks or more, the contract is marked as suspicious.

To enable the analysis, select “Contract declared by both NS and EW” and/or “Double dummy check” and enable
“Automatically check results for suspicious contract”. Incoming contracts will be automatically scanned for any
suspicious contracts. In order to analyze all current results, click the “Check now” button.

Suspicious contracts are displayed in red in the Results and Result matrix pages. If you determine that a contract is
not suspicious, double-click on the result entry and click on “Contract is valid.” The contract now displays in green.

There is a detailed write-up on our website: www.bridgemate.us/media/downloads/suspicious-contracts.pdf

Creating Reports
Hand-record data from the right-hand display may be copied to an external file. For example, this can be used to
create a report that compares the results achieved by the various teams that played each board.

e Gotothe menu Tools - Show/hide columns to select the columns to be in the report.

e Select the records by highlighting the first entry for the report — hold the Shift key down and press End or use
the 1 or | key to select the desired records.

e Right click on the highlighted records and select “Copy scores to clipboard.”

e The comma-delimited data may then be “pasted” into an external program (such as Word and Excel).

Note: If the result (.bws) file (i.e., 070904E.bws) is opened by a different client computer, the results will not be
immediately displayed in the right-hand panel. Follow the procedure shown under Managing tables, Taking over
tables from another client, on page 16.

Result (.bws) file tables may be imported direct into Excel 2007/2010. Data > Get External Data / From Access >
change lookup to “All files” = change file extension from .bws to .mdb - Open - select desired table - Open.

Changing and deleting board records

Changing records

Right-click on the record you would like to change and select Edit score. A detail screen will appear displaying all the
score data. You can now edit the result: Declarer is pair that played the hand; NS/EW is the “declarer” player;
contractis#=C, ¢ =D, v=H, =S, no trump = NT, double = x, redouble =xx, pass = PASS. Enter a space
between the value of the contract, the contract type and double/redouble. With “American Style” enter the numbers
of tricks taken — or number of tricks down.

If the board result has not yet been posted into ACBLscore, the change can be performed in BCS and then it will be
read into ACBLsciore correctly. However, if the board result has already been posted into ACBLscore, that score will
have to be manually “corrected” in ACBLscore; the score may also be changed in BCS in order to have correct
traveller and percentage information shown on the Bridgemates — and correct results for website displays.

Note that any changes made to the results in the result (.bws) file will be fed back to the server. Bridgemates will
therefore show the edited result in the overview of previous results.

If you wish to change a score from the result matrix, double click on the score to pop up the edit score window.

Deleting results

To delete a board result, right-click on the entry you would like to delete and select Delete score. To delete multiple
records simultaneously, highlight the first record - hold the Shift key down and use the 1 or | key to select the records
you would like to delete; alternatively, hold the left mouse key down and select records. The result will also be
deleted from the server. A new score can be entered in the Bridgemate.

Note: Deleted records will not be removed from ACBLscore if the result(s) were already posted into ACBLscore.

Scores cannot be deleted through the result matrix.

Opening and closing result (.bws) files

If no result (.bws) file is open in BCS, options are limited. The Session menu is inactive and no server data can be
processed. During normal BCS use, ACBLscore creates and then F11 - BMS causes BCS to read the result (.bws)
file. You do not need to open the result (.bws) file or read the relevant session data. To read other result (.bws) files
in BCS, use the Open and Close functions in the File menu.


http://www.bridgemate.us/media/downloads/suspicious-contracts.pdf
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Opening existing result (.bws) file

Use the File > Open menu to open an existing result (.bws) file. If this result (.bws) file has not been opened
previously on this client, BCS will ask whether the client wants to log in to this result (.bws) file. This step is
necessary to add tables to the client and interact with the result (.bws) file.

Closing the result (.bws) file
Select File &> Close to close the active result (.bws) file. You can now open another result (.bws) file.

Using multiple clients

In ordinary club sessions all scoring is done of one computer. In large tournaments, however, it may be necessary to
split the session over multiple computers each serving a selection of the tables, while having the scores collected all
in one Bridgemate result (.bws) file. BCS supports multiple clients simultaneously logging in to a single result (.bws)
file and storing scores during the session from multiple Bridgemate servers.

In order to change the program to multiple client mode, go to menu Tools = Options =2 tab General, and set the
mode to “Tournament”.

The list of tables will now show two tabs: “All tables” and “Client tables”. The All tables tab contains all the tables
stored in the result (.bws) file. These are generally all the tables used in the session. The Client tables tab displays
the tables assigned to the client PC you are currently using. The name of this client is displayed in the bottom left-
hand corner of the screen. The tables must be assigned to a client. If you are using one PC for your sessions, all
tables will be assigned to the same client. In this case, the All tables and Client tables tabs contain the same tables.
If you are using multiple clients, the All tables tab contains all tables in the session; the tables may be assigned to
different clients. The Client tables tab only displays (on both PCs) those tables assigned to that specific client.

The scoring program will create the result (.bws) file for you. By default it is assumed that only one client is used.
The program will automatically assign all tables to the PC you are currently using. You do not need to perform any
manual changes. Manual changes are only required during big tournaments involving the use of multiple clients and
servers.

Adding a client to the result (.bws) file

The result (.bws) file keeps track of which clients are using the result (.bws) file. Your scoring program will
automatically add your client to the result (.bws) file.

If the result (.bws) file has not previously been opened by the client PC (it was created on another PC), this client has
not yet logged in to and cannot use the result (.bws) file. To add a new client to the result (.bws) file, open the result
(.bws) file on the relevant client. Confirm that the client is to be logged in to the result (.bws) file. The result (.bws)
file may now be used.

Managing tables — Tournament (network) mode

Assigning tables to a client

Once a result (.bws) file has been opened, all tables of the result (.bws) file will be displayed. In Tournament
(network) mode the All tables “Client” column will display the currently-assigned Client, or “not assigned” if the table
is not assigned to any client. To assign a table to the client you are currently using, right-click on the table and select
Add to client. To add multiple tables simultaneously, select the table by clicking and holding the left mouse button
and the Shift key, or use the Select all function to select all the tables. Once the table has been added to the client,
the client name will be stored in the table. You can only assign tables to the client (PC) you are currently using. If
you are using multiple clients in a network, the result (.bws) file will need to be opened manually per client and the
tables added to that client.

Taking over tables from another client

To transfer a table that has already been assigned to another client to your own client, repeat the above procedure.
Right-click on the table and select Add to client and confirm you would like to take over the table from another client.

Overview of tables assigned to a client
The client to which the tables have been assigned is displayed in the “Client” column of the All tables tab. The Client
tables tab only displays those tables assigned to the current client.
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Removing tables from the client
Click on the Client tables tab for an overview of all the tables added to this client. Right-click on the table you would
like to remove and select Remove from client. The table will now be removed from the client.

Server control

Activating the server

To activate the server, connect it to the client PC and connect the power adapter or fit batteries. Once the server has
been found, specific data will be displayed in the top left-hand corner of the BCS screen and the Server menu will be
activated. You are advised to connect the server before launching BCS.

Resetting the server
The server contains no data when initially connected to a power source. New tables can be added instantly.

If the server contains data which you would like to delete, you will need to empty the server. This is done using the
reset function. Go to Server > Reset. You will be asked to enter a verification number which is displayed on the
screen. This verification number ensures that the server cannot accidentally be reset. Once the correct verification
number has been entered, the server is emptied and all data removed.

Adding tables

The server is activated by adding tables. As soon as a table has been added, the server feeds this data to the
corresponding Bridgemate, which in turn is activated. The Bridgemate cannot operate if the corresponding table has
not been added to the server. Tables can only be added once to the server. If you attempt to add a table that has
already been added to the server, an error message will be displayed.

To add a table to the server, go to the Client tables tab, select the relevant tables, right-click on one of the tables and
select Add to server. The tables will now be added one by one to the server, and the corresponding movement
loaded per table. An overview of the added tables will be displayed.

Removing tables

It is also possible to remove tables from the server using the Client tables tab. Select the tables you would like to
remove, right-click on these tables and select Remove from server. The tables will now be removed. You will not be
able to use any Bridgemates that are configured to these tables.

Synchronizing the server and client

All data relating to tables is saved separately in both the result (.bws) file and the

server. Inthe event of a temporary disconnect between the server and the PC, there
can be discrepancies between the server and the result (.bws) file. These discrep- -
ancies can be rectified using the Session = Synchronize / recover menu function. e

Check the relevant options to indicate your synchronization preferences.
You must determine whether to synchronize the server to the result (.bws) file,
or whether to update the result (.bws) file using the data stored in the server.

Tables in server which are not in client

Use this option to determine what to do with tables stored in the server but not assigned to the client. To delete
these tables from the server, select “Delete from server”. To add them to the client, select “Add to client”. Tables
that have already been assigned to another client can only be assigned to the current client if the “Take over from
other client” option has been checked. If this box has not been checked, the tables cannot be added to the client.

Tables in client which are not in server

Conversely, some tables may have been assigned to the client but not to the server. To add these tables to the
server, select the “Add to server”. To delete these tables from the client, select the option “Delete from client”. This
option also allows you to delete all the tables from the result (.bws) file by checking the “Delete from session” option.

Delete tables from server which are not in session

The synchronization function will also verify whether the server contains tables not contained in the result (.bws) file.
These are so-called “obsolete tables”. Check the “Delete tables from server which are not in session” option to
delete these tables from the server. If this option is unchecked, these tables will not be removed.
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Synchronizing client to server and vice versa

As outlined above, the main function of the synchronization process is to synchronize the client to the server and vice
versa. The default settings of this function are configured to synchronize the client to the server: tables that have
been assigned to the server but not to the client are added to the client, and tables that have been assigned to the
client but not to the server are removed from the client.

These settings will need to be adjusted when synchronizing the server to the client. In this case, delete all tables
from the server that have been assigned to the server but not to the client (select “Delete from server”). Conversely,
add to the server all tables that have been assigned to the client but not to the server (select “Add to server”).

In all these cases, make sure the “Delete tables from server which are not in session” option is checked to delete all
tables that have been assigned to the server but not the result (.bws) file (and therefore not to the session). Should it
transpire that these tables were correctly stored in the server and not in the result (.bws) file, a new result (.bws) file
will need to be created, or the current file updated.

Recovering the server

The Synchronize menu function also offers users the opportunity to fully synchronize the result (.bws) file and the
server. To do this, go to the “Recovery” tab and press the “Recover server” button. All existing data will be deleted
from the server and overwritten with the tables and the data contained in the result (.bws) file. The server is
synchronized with the current position of the result (.bws) file. This function is ideal if the server loses its data and
you wish to reconfigure the server with data that has been recorded in the result (.bws) file.

; i =
Updating movement in the server Se— *
Movement data is assigned to all tables added to the server during the Bl Section A e |

. . . . . [w] Section B
synchronization process. The synchronization function does not update

the movement data of tables already stored in the server and which have
not been updated. If the movement data of the result (.bws) file has been Usdae meveren satng (7]
synchronized from the scoring program, and the scoring program does not

order BCS to update this data, use the Session - Update movement
function to update the server with the correct movement for these tables. L Updderon

All sections are checked by default. Uncheck all sections that you do not

wish to update. By default, data is updated from round 1. To update from a later round, select another round
number using the selection option. Press Update now to update the sections with the correct movement. Any table
data belonging to sections that you wish to update will now be deleted from the selected round onwards. A report will
be displayed of the executed operations.

When updating from a later round option to “Erase results from prior Ukt ozt sallrg 7|
rounds...” will appear. If this is checked, all Bridgemates will start from fom rounet

the selected round. However, this will erase all movement info of the
previous rounds and delete all scores from the server for those rounds.
Be very cautious with this functionality. If you only want to move the Update now ‘
Bridgemates to the next round, use the “Close rounds” function.

- Eraze rezults from prior rounds and continue Bridgemates
from round 3.

Note: The scoring program normally updates all movements in BCS automatically. It is therefore not necessary to
invoke this function manually.

Closing rounds
i Select sections ———————————————

If a Bridgemate hasn't received all the scores of a round and it needs to be moved on the ¥ Section &

next round, for example due to late play or when players didn’t enter their score in the W Section 8

Bridgemate, you can simply close the round in BCS and force all Bridgemates to move on to
the next round. Go to menu Session - Close rounds.

Close round 1 bo: 1 'l

Select the sections of which you want the Bridgemates to move on, and select the number
of round you wish to close. For example, if you want all Bridgemates of section B to move
on the 4™ round, then select only section B by deselecting the other sections, set close
rounds 1 till 3 (not 4!), and press “Close rounds”. All missing scores up to round 3 for all
tables of section B will be filled up with Not played, and this will also appear in the result list
and result matrix. Bridgemates of section B which are still in round 3 will automatically move on to round 4.
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Program Settings (Options)
Change program functions using menu Tools - Options = General.

To disable the automatic server detection while the program is e
running, check Disable server detection. You may wish to do this iode flenapiatns

when BCS is running without a server connected. During sessions, : b e st S s
. . . Jourmamen o
however, you are always advised to leave this function unchecked. Il B aicieliee e sares
. . [ Shaw Brid te opti hen starti

To close BCS automatically at the end of a session, check “Close B
program at end of session.” This requires that all tables — at least BridgemzjeeErver

one time during the session — have been logged in (with their status
indicators green) and, at end of the session, all tables have finis
and are Iogged Off Autopower-off period: 1 hour -

The Erase original records of deleted stores is required when using ACBLscore.
To view the settings that Bridgemates will be used before the Bridgemate system is actually started, check “Show

Bridgemate options when starting new session.” This allows the TD to verify if all settings are correct and make
changes where needed — before the movement is actually loaded into the server.

Options - General

View ] File Iocations] Scoring plogram]

Dizable server detection
[Does nat disable server detection at startup|

Tab View
Ge: {Wiei"| File locations | Scoring program |
When ACBLscore updates the movement, the result is shown on the Display Rsult i
BCS screen through a report window. You may manually close this o g e P
report, or it will close automatically after 60 seconds. o e Lo dupiased g Dol
American o tyle =] ® B e

“American Style” should be displayed for North American operation.

Show contract / score points:

Result matrix display options are discussed in Chapter 8. o8 D

" Orly score points
Qptions - General File locations

General | Wiew Scaring program

* Cortizcts and score points

The default “Log files” location is the “User Appdata folder.” Note, this is normally a
L:g fles Windows® hidden folder. Should you wish to use a “non-hidden” folder, the “Other
P 2 progtam felder folder” should be checked — then use to specify a non-“Program

* User appdata Folder

& [ e Files” folder such as C:\ACBLSCOR. Do “\ACBLSCOR to use as the log-
file location. Special Note: When BCS is being used by more-than-one Windows®
User, a single log file is desired. To do this, configure each User’s

TP'E‘PB'DB“" database fe BCS options to use the same “Other folder.”

BEkPro exe program folder
& User appdc.fa filde, The special BMPlayerDB.mdb player-name lookup file for the National Tournament (or
" Dther folder. large local) database will be located in the hidden “User Appdata folder.”

__Selectfoider | When there are multiple Windows® Users expecting to use the special

BMPlayerDB.mdb lookup file, special arrangements are required. )
Options - General

SCO” ng Prog ram and Player Da'ta'b ase Genelal] Wiew ] File locations  Scoring program ]

ACBL affiliated Clubs/Units should select ACBLscore as the scoring program in | *eegpreaan speeiic options
use; also, check the “Load player database after BMS command.” This works Searing programin use: ACBLscore
well when your “local” (Club mode) database is not too large; i.e., perhaps no
more than 10 to 15,000 names. Club player names
IV Load player database after BMS cormmand

Should your ACBLscore program (and player database) be located in a drive et ot CAALELsco Db
other than the C:\ “root directory,” click on “Change location” so that BCS can —
find the database file when it is started from ACBLscore. [P

To use ACBL’s very large “Tournament” (or a large “local”) database, click on Toumament player names:
“Load tournament database” to load/update the special BMPlayerDB.mdb file. Load toumament dotsbass. |
This action will take several minutes.

Bridgemate app

The Bridgemate® App is a personal add-on to the existing Bridgemate Pro or Bridgemate Il Scoring System. By
using the app, during or after the game, players can consult their guide card for the next round settings, review their
scores, view current ranking or see their competitor’s scores as well as hand records for the boards already played.

For complete details on using the Bridgemate App, visit our website www.bridgemate.us = “App”



http://www.bridgemate.us/app/
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Chapter 4: Server Functions

Once the server is connected to the PC, the BCS Server menu is active. This menu contains several useful server
functions. It is not necessary to open a result (.bws) file to use these functions.

Overview of tables Show tables X

Total numbers of tables in server: &

Use the Server - Show tables menu to create an overview of the Delete tabiefs
tables stored in the server.

Log off tablefz]

TER DT
*Se08e

Per table, the green or red status light indicates whether this table Show scores
has logged in to the server, logged off, or has not yet logged in. Aetiove scoree

To delete a table from the server, select the relevant table(s) and
choose “Delete table(s)”. The table(s) will be deleted from the Undate setiings
server, as will all the data of the table(s).

To log off a table manually, select the relevant table(s) and click

“Log off table(s)”.

Click the “Show scores” button to create an overview of the results entered by the Bridgemate. Select the table(s) of
which you would like to see the board results and select this function.

When the Bridgemate settings have been modified, they are updated in the Bridgemates by selecting the tables and
clicking “Update settings”. The updated settings will become active in each Bridgemate when it is “reset” and logs in
again; the Bridgemate will return to the position where is was before the reset and will now use the new settings.

Click the “Retrieve scores” button to move all entered results for the selected tables to the result (.bws) file.

Overview of entered results

The Server = Show all scores menu function displays an overview of all board results entered in the server.
Depending on the number of tables stored in the server, there may be a delay in reading and displaying the data.

Restarting Bridgemate network

The wireless network can be restarted from the server using the function Server > Restart
network. Use this function to solve wireless communication problems between multiple
Bridgemates and the server. This may be done at any time; it does not interrupt anything.

v

Resetting the server

The Server > Resef menu function resets the entire server and deletes all entered data. To avoid accidental resets,
you will be asked to enter a verification number which is displayed on the screen.

Note: If the server is not connected to the power adapter and/or is not fitted with batteries, all data will be lost. Itis
therefore not necessary to reset the server before disconnecting it from the power source or after connecting it to the
power source.
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Setting the region

X

The Bridgemate Scoring System communicates over a Region selection

predetermlneq frequency ;pectrum. The pe.rmltted Regional settings Close
frequencies differ per continent. Three continents are et reslan Wah e

currently supported: Europe, North America and Australia
/ New Zealand. When first launching BCS with a new
server attached, you will be asked to select your region.
The server will select the corresponding frequency
spectrum to communicate with the Bridgemates.
Remember to use the correct Bridgemate firmware for
your region. For North America, the firmware version with country code US is used. This country code is displayed
on the start-up screen of the Bridgemate.

Mew region: | Morth America j

If you want to change the regional settings of the server, go to Server > Region selection.

The “Current region” function displays the current region. Select the new region and press “Set”. The new region
has now been set. Remember, however, that Bridgemates must have firmware for the region selected.

Setting the channel

The server and the Bridgemates must be set to the same channel to communicate with each other. To set the
channel on the server, use the Server - Channel selection menu.

Channel selection El
Channel settings Close
Current channel: ]
Mew chariel: m
Set

The “Current channel” function displays the current channel. Select the new channel and press “Set”. The new
channel has now been set in the server.

System functions

Update firmware.

The server’s firmware may be updated in the future. If there is an update, download the new firmware from
www.bridgemate.us and follow the instructions carefully.

Program Shutdown — Power Outages — Change PC
The following website page describes actions that may be taken to recover from these special conditions.:

www.bridgemate.us/how-to-quides/during-a-game-program-shutdown-power-outage-change-pc/



http://www.bridgemate.us/
http://www.bridgemate.us/how-to-guides/during-a-game-program-shutdown-power-outage-change-pc/
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Chapter 5;: Use of the Bridgemate® Pro scoring devices

The Bridgemate is a small device designed to enhance the enjoyment of
bridge for tournament directors and bridge players alike. The system ~
enables you to enter results faster than before, and is guaranteed to
prevent operator errors. As well as allowing players to enter board results, %

the Bridgemate also feeds information to the players, such as the achieved :

percentage on the board played, and the traveler overview. We are _T/ 2 Y/ a NT
convinced that tournament directors and bridge players will appreciate the ‘/aﬂéj Q
convenience of the Bridgemate! ﬂﬂyé’i}

Preparing the Bridgemate for use %E’ﬁ/ﬂ
The Bridgemates are individually packed in compact sturdy cardboard

boxes. Each Bridgemate comes complete with four AAA batteries, which
must be inserted into the bottom of the Bridgemate unit. The + and — signs
in the casing indicate the insertion direction of the batteries. Insert all four :

batteries in the direction indicated, close the lid and press the OK button. Check whether the text “Bridgemate Pro”
appears. The Bridgemate is now ready for use.

Exploring the Bridgemate

The keyboard

The Bridgemate keyboard contains 25 keys. Some of the
keys have a dual function.

Keys Explanation

These keys are used to enter numbers in the Bridgemate, for
example board numbers, pair numbers, contract and result. The
10 button is used to enter 0 (when entering member numbers,
board numbers etc) and to indicate 10 as the lead card.

1t0 9,10

These keys enable you to indicate the contract type or the card
color of the lead card.

&, ¢, v A NT
T = Indicates overtricks or downtricks of the result.
= Indicates that the contract has been exactly made.

Use these keys to specify Jack/Queen/King/Ace as the lead
card.
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X, XX Double or redouble.

N/S, E/W Declarer’s direction of play.

PASS Indicates a pass-out.

CANCEL Correct (erase) an entry and cancel commands.
OK Confirm an entry.

Switching on/off

The Bridgemate does not have a separate on/off button. To switch on the Bridgemate, press the OK button. It is not
possible to switch off the Bridgemate manually. The Bridgemate will automatically switch off after it has been idle for
a while, i.e., no buttons have been pressed. No data will be lost when the Bridgemate switches off. Simply press the
OK button to continue as before. In other words, you can continue entering results as soon as the Bridgemate has
been activated again.

The default autopower-off time is set to 20 seconds. This value can be changed to between 5 and 60 seconds. See
Chapter 6 for more information.

Activating the Bridgemate

When switching on the Bridgemate for the first time, you will be taken to the main screen:
BRIDGEMATE PRO
v2.3.2a US (version number and language code may differ)

Press the OK key again to view the Bridgemate’s Section / Table settings. The default setting is Section A, Table 1.

Configuring Bridgemates for Section/Table entry at each table at the beginning of a game/session.

1. Bridgemates may be configured for manual Section and Table entry at each table at the beginning of each
game/session. When the “Bridgemate Pro” screen displays - insert the TD-key in the Bridgemate. The
following screen will appear: SECTION: A  +/-

TABLE: 1

2. Use the minus (-) key to change the display to read: SECTION: SEL +/-
TABLE: SEL

3. Press OK to confirm the “SEL” configuration. The screen will now display: CHANNEL: O

4 _ If you wish to leave the channel number unchanged, press OK. To use a different wireless channel, press the
CANCEL button to delete the number, then enter the new channel and press OK. The Bridgemate will confirm
that the settings have been saved. The SEL configuration remains active until changed by using the TD key.

To exit the screen without making any changes, simply remove the TD-key.

Pre-assigning Bridgemate Section and Table

1. You may program the Section and Table for each Bridgemate. To do this — when the “Bridgemate Pro” screen
displays - insert the TD-key in the Bridgemate. The following screen will appear: SECTION: A  +/-
TABLE: 1
Use the + and - key to adjust the Section. Sections range from A to Z.

3. Press OK to confirm the section. The following screen will now be displayed: SECTION: D
TABLE: 1
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4. Use the number keys to set the correct Table number. Press CANCEL to delete the current number. Table
numbers range from 1 to 511.

5. Press OK again to confirm the table number. The screen will now display: = CHANNEL: O_

6. If you wish to leave the channel number unchanged, press OK. To use a different wireless channel, press the
CANCEL button to delete the number, then enter the new channel and press OK.
The Bridgemate will display a message informing you that the settings have been saved. The Bridgemate
will retain these settings until you next change the section and table number. In other words, these settings
will be retained even after the session has been completed. It is therefore not necessary to change the
settings for the next session. All you need to do is move the Bridgemate to the correct table.

Activating the server

For more information on how to activate the server, please see Chapter 3.

Replacing batteries

The Bridgemate will check the remaining battery life each time it is activated for a new session. If the battery power
is extremely low, the “Replace batteries” message will appear. Although it is safe to continue using the Bridgemate
for several more sessions, it is recommended that you replace the batteries as soon as possible. The average
battery life is approximately 300 sessions. However, this depends largely on the length of each session, the time
frame over which these sessions are played, and how the Bridgemates are stored.

Entering results with the Bridgemate

Who operates the Bridgemate?

As with the score card, the Bridgemate is normally operated by North. North is responsible for the correct operation.
East (or west) is responsible for verification of the entered board results.

Switching on/off

To switch on the Bridgemate, press the OK button. The Bridgemate will automatically switch off after it has been idle
for a while, i.e., no buttons have been pressed. No data will be lost. Press the OK button again to continue.

Activating the Bridgemate

At the start of the session, the Bridgemate will, by default, display the “Bridgemate Pro” main screen, including the
version number and language code. Press OK to view the Bridgemate’s Table and Section settings.

e Pre-assigned Section/Tables: The display will show the assigned Section/Table, i.e., SECTION: B
TABLE: 3

To activate the Bridgemate and log on to the server, press OK again.

e Manual Section/Table entry: The first line will show the last-used Section, i.e., SECTION: A  +/-
If needed, press + or — to change the Section letter. Press OK.
Enter the Table number and press OK. TABLE = A2 will display.
CONFIRM -> OK If this is correct, press OK.

The Bridgemate has now been activated and can be put into use.

Entering member numbers (optional)

If you have specified in BCS that you wish to enter member numbers, the Bridgemate will ask you — after activation
and before the start of the first round — to enter the member numbers of the four players.

Nz and E:

S: W:

The number must be numeric and has a maximum of 12 digits. Use the number keys to enter the number, and
confirm by pressing the OK key. If a player does not know his member humber or does not have a member number,
press OK without entering a number. No number will be registered for this player.
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Once a member number has been entered for West, the numbers will be fed to the server and the Bridgemate will
start the first round.

Information before the start of the round

At the start of each new round, the Bridgemate will display the new round and the expected pairs, as well as the
direction of play. The board numbers will also be displayed. For example, you can verify at the start of the round
whether you are seated in the correct direction and have the correct boards on the table. This information is
displayed as follows:

ROUND 1, 1-4

NS: 1 EW: 2

Press OK to confirm this screen and continue with the board input.

Entering board results

The following screen will be displayed when entering the board results:
BOARD: _
CONTR:

The flashing line indicates the input position. Before starting the game, enter the board number and press OK to
confirm. The Bridgemate will verify the number. An error message will be displayed if the board number does not
appear in that round:
BOARD NUMBER
INCORRECT! R1

R1 indicates that the Bridgemate is in round 1. The message will disappear after a few seconds — or you may press
CANCEL. You will now be asked to enter the correct board number.

If the board is entered a second time within the same round, the following message will be displayed:

BOARD ALREADY
PLAYED! R1

It is not possible to enter a board twice in the same round. If the board result has been entered incorrectly and
requires correction, call the director. If supported by your scoring program, the director may “delete” the board result
using the TD-key and the correct score may be entered.

Use the Bridgemate settings to indicate whether you would like the Bridgemate to check whether the entered board
number corresponds to the logical order. If the Bridgemate expects a different board number to be entered, the
following message will appear:

BOARD OUT OF

ORDER, ACCEPT?

Press CANCEL to return to the previous screen and press CANCEL again to erase the board number and to enter a
new board number. If you do wish to play an out-of-sequence board, press OK. The board number will be accepted,
and the Bridgemate will assume that you have chosen to deviate from the logical order.

Once the board number has been entered and confirmed, the cursor will jump to the second line. You can now begin
bidding. As soon as the contract has been determined, enter the contract and the direction of the declarer.

To enter the contract, use numbers 1 to 7 and the &, ¢, v, o and NT keys. If required, you can also use the x and
xX keys to indicate double or redouble. To specify the declarer, use the N/S and E/W keys. If the declarer is North,
press N/S once. If the declarer is South, press this key twice. Alternatively, if the declarer is East or West, press
E/W once or twice. The screen is displayed as follows:

BOARD: 13

CONTR: 3NT x E_
Press OK to confirm this.

If the OK key is pressed before the Declarer has been entered, the display will read: ENTER DECLARER
N/S or E/W
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Entering lead card (optional)

If you have specified in BCS that lead cards must be entered, the Bridgemate will ask you to enter the lead card.

LEAD:
RESULT:

Select the lead card using keys 2 t0 9, 10, J, Q, K or A and the card type using %, ¢, ¥ or a. You are free to decide
in which order to enter the card and the card suit. Press OK to confirm the lead card.

Entering the result

Once you have finished playing the board, you can enter the result. Using “American Style,” when the contract has
been made enter the number of tricks taken. If the contract was not made, use the — key followed by the number of
tricks “down.” The = key may also be used when the contract has been exactly made.

Depending on the settings in BCS, the result can also be entered as the total number of tricks won (i.e., 0 to 13) or
Up/down tricks. When using Up/down, enter = key when contract has been exactly made, the + key followed by the
number of “overtricks,” or the — key followed by the number of tricks “down.”

Verification by East or West

Once you have entered the contract, the lead card (if requested) and the result, press OK. "Verification by East or
West" will display. The Bridgemate must now be passed to East or West to verify the entered data.

The verification screen will for example be displayed as follows:

Board 13, 3NTx +1 Board 13, 3NTx 4
by East, -950 by East, +950

The board data entered by North is displayed on one total screen (the lead card will not be displayed). In addition,
the number of score points obtained on this board will be displayed. Depending on the BCS setting, the number of
score points will be displayed as assigned to the North/South pair or to the Declarer.

Confirming board result

East or West verifies the data displayed on the verification screen. If this data is incorrect, East or West will press
CANCEL to edit the data. If the result is correct, East or West will press OK to confirm the result. The message
“Entry completed” will now be displayed. The data is saved and sent to the server. Itis now no longer possible for
players to edit the results.

Overview of percentage achieved and previous results (optional)

Once East or West has confirmed the board result, players have feedback options for viewing their achieved result
and board results achieved by other pairs. Depending on the BCS settings, the following information can be
displayed:

e Achieved percentage for the entered board result

e Overview of scores at other tables on the entered board

If one (or both) of the functions is activated, the message “Entry completed” will also display the text “Show
results?”. Press OK to view information on the achieved board result.

The percentage achieved on the board will be displayed first. This is done by reviewing the other results registered
on the board, the value of the entered score and how the entered score compares with the other results. This
percentage will have little significance at the start of a session. As the session progresses, the percentage will
approximate the actual end percentage on the board.

3NTx E +1 /when showing \ 3NTx E 5 /when showing \
-950 = 33% \North/South results/ +950 = 67% \declarer results/

The percentage relates to the achieved number of score points. Depending on the BCS setting, this always applies
to the North/South pair and/or the declarer. Press OK to exit this screen.
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If you have set BCS to also display the scores of other pairs on the entered board, the Bridgemate will display these
results. This screen is displayed as follows:

S 2§ 2 +110
E* 3NTx 4 -950

The scores are sorted from high to low on the basis of the achieved score points of North/South. The score achieved
by the table (viewing the results) is displayed with a * (optional). The scores are displayed in pairs. If there are
multiple board results, press OK to view the next results.

It is possible to set BCS to view the scores again after they have all been displayed.

End of round

At the end of the round, the Bridgemate will display the message "End of round". You do not need to do anything.
The Bridgemate will automatically switch off after a few seconds. Press OK again to begin entering the results in the
next round.

End of session

At the end of the last round, the Bridgemate will display the message “End of session” and return to the Bridgemate
Pro main screen after a few seconds. The Bridgemate has completed its tasks and can now be safely stored away.

Special entries: Pass-out and board not played

If the players have passed four times without making a bid, enter ‘Pass’ at CONTR and confirm with OK. You will not
be asked for the lead card and the result; the Bridgemate will switch immediately to the verification screen.

If a board has not been played in a particular round, e.g., due to time constraints, the Bridgemate must be informed.
If this step is skipped, the Bridgemate will remain in the uncompleted round, and other pairs will be prevented from
entering their results. To enter an unplayed board, press the 10 key in the CONTR row. The screen will now display
the text "NO PLAY”. Confirm by pressing OK. The Bridgemate will now display the verification screen again.

The Bridgemate will not display an overview for unplayed boards. As it is possible to play the board in a later round,
players must be prevented from seeing the results of previous boards. The board can be played afterwards without
the Bridgemate; in that case, the relevant score is entered manually in the scoring program.

Rectifying an input error

If you have made an input error, press CANCEL to rectify the error. You can to return to the board number input
screen by repeatedly pressing this button. It is also possible for East or West to reject the entered data by pressing
CANCEL. The Bridgemate will now return to the input screen, and the entered data can be deleted by pressing
CANCEL again. Once East or West has confirmed the score and the message “Entry completed” has been
displayed, the score cannot be edited. Only tournament directors are authorized to change a score after it has been
verified.

Please note:

e |tis not necessary to enter the number of score points (+420, -50 etc.) in the Bridgemate. The Bridgemate
will calculate the score using the entered contract and result, taking vulnerability into account.

e The Bridgemate monitors the active rounds. In case of a sit-out, the Bridgemate will skip this round.

o Before starting a new round, verify whether you and your opponents are seated in the correct direction to
avoid playing in the wrong direction. At the start of the round, press OK to display the directions.
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Posting Bridgemate Pro results

Results to Bridgemate Control Software

Information entered on the Bridgemates is first saved on the server. The BCS program continuously reads the data
from the server and stores these in the result (.bws) file.

Posting scores in the scoring program

Once the results have been saved in the result (.bws) file, your scoring program can read and process the scores.
For more information, please consult the manual of your scoring program.

TD menu

Tournament directors have far-reaching powers to verify the entered results. A special TD menu is available for this
purpose. To access this menu, please use the TD-key supplied with the package.
Activating the menu

To activate the TD menu, insert the TD-key in the communication port of the Bridgemate. This requires the
Bridgemate to be switched on and waiting for data to be entered (board, contr, lead, result input screen). Itis for
instance not possible to activate the menu if the device is in the verification screen or is displaying an overview of
previous results.

To exit the menu, simply remove the TD-key.

Menu options
Once you have inserted the TD-key, the following screen will appear: TD-MENU
The TD-Menu seven options:
1. To enter an arbitral score, press ‘1.
2. For an overview of the entered scores, press ‘2'.
3. To delete an entry, press ‘3". [Note: Only use this if supported by your scoring program.]
4

If you would like to view the corresponding table and section of the Bridgemate and/or the corresponding
round and pairs, press ‘4’ (retrieve status).

o

To retrieve an overview of the board numbers not yet entered, press ‘5.
To reset the Bridgemate, press ‘0'.

7. To set the contrast of the screen, press + or -.

Entering an arbitral score

It is possible to specify in the Bridgemate that an arbitral score must be entered for a certain board. Proceed as
follows: enter the board number and confirm with OK. The cursor is positioned at CONTR. Insert the TD-key in the
Bridgemate to activate the TD menu. Press '1' and confirm (OK button) “Arbitral score?” Next, enter the arbitral
score for each pair: NS: _

EW:

You can choose between 40% (average-minus), 50% (average) and 60% (average-plus). Press 4 or — to enter 40%,
5 or = to enter 50%, 6 or + to enter 60%. It is not possible to enter a value other than these percentages. Press OK
after you have entered the percentage. Do this for both pairs. The screen will now return to the TD MENU. Remove
the TD key. The assigned arbitral score is how displayed at CONTR. Press OK to confirm this, and confirm the
verification screen. The Bridgemate has now saved an arbitral score for this board and will feed this to the scoring
program during read-out.
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Retrieving overview

To obtain a board overview without reading the data or completing a board input, it is possible to use the special
overview function of the TD menu. To access this overview, insert the TD-key and press ‘2’. You will be asked to
enter the corresponding board number. The overview displays the declarer pair number, declarer position (e.g., N,
S, E, W), contract and result. The number of score points is not displayed in this overview. If the screen returns to
the TD menu after the board number has been entered, no results have been registered for this board at this table.
Note that results that have been entered on the same board but in other Bridgemates, will not be shown in this
overview.

Erasing entry

Directors have always the option of erasing entries. This can either be a board result from the current round or the
previous round. If board results have not yet been entered in the current round, the board result of the previous
round will be erased. This method enables you to erase all results from the Bridgemate.

To erase a board input, insert the TD Key, press ‘3’ and press OK when prompted to confirm “Erase result?” You will
be asked to enter a board number. Enter the board number and confirm with OK. If that particular board can be
erased, the message “Board erased” will be displayed to indicate that the entered result has been erased. If the
board has not yet been played, or not played at this table in the current or a previous round, the TD menu will be
displayed again after you have pressed OK.

Once a board result has been erased, the correct information may be entered.

Note when using the ACBLscore: Board results may be erased at the Bridgemate only if the result hasn’t already
been posted into ACBLscore. Once a board has been posted into ACBLscore, the correction must be made in
ACBLscore

Retrieving current status

If you no longer know to which table and section the Bridgemate relates, you can retrieve this information in the
status part of the TD menu. To do so, insert the TD-key in the Bridgemate and press ‘4. Press OK when prompted
to confirm ‘Status?’ The expected table and section of the Bridgemate will be displayed first. Press OK again to view
the current round of the Bridgemate and the corresponding pairs at the table. You will also see the boards to be
played in this round.

Overview of missing results

From the TD menu, it is easy to establish which boards of the round have not yet been entered. Press ‘5’ and OK
when prompted to confirm ‘Missing boards?’ The Bridgemate will now display the numbers of the boards not yet
entered in this round at this table.

Resetting the Bridgemate
The Bridgemate can be reset from the TD menu. Press ‘10’ and OK when prompted to confirm ‘Reset?’. It will now
return to the main screen.

Setting contrast

It is possible to set the contrast of the screen from the TD menu. Press + to make the screen darker, —to make the
screen lighter. Press the button several times to adjust the contrast. It is also possible to adjust the contrast —
without using the TD Key — if the Bridgemate is displaying Bridgemate Pro in the main screen.

Please refer to the “Solutions for non-functioning Bridgemates” laminated sheet — Items 5 and 6 for procedures to
follow if the screen is all black or there is no display at all.
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Reading results manually in Bridgemate

All entered data are also saved in each Bridgemate’s local memory. If for whatever reason a Bridgemate is unable to
feed one-or-more board results to the server, the results may be read manually into BCS at the end of the session.

Connect the Bridgemate Communication Cable to a serial port of your Quldeemate® Control 26 twate

PC On the BCS menu SeleCt Sess|0n 9 Read Brldgemate LOCa”y \i:) Connect the Bridgemate communication cable ko the serial port and click O,
Click OK on the screen display.

Cancel

Read Bridgemate locally Connect the Bridgemate
Chatus Communication Cable to the Bridgemate via the data port at the back

Activate Bridgemate and connect it to the communication of the Bridgemate- Press OK on the Bridgemate-
cable. ..

All board results from Read Bridgemate locally
this Bridgemate are read and stored in the result (.bws) file along with Shatie
any of this Bridgemate’s results that were already received by the Connect: Bridgemate v2.3
server. These results can now be processed in the scoring program Reading data for section &, table 2

in the usual way. They are also displayed on the BCS screen. Ready

This function can be used, for example, in the event of PC and server data loss. See Chapter 7, page 33 Server
data loss, for more information about the applicable procedures in the event of data loss.

Options - Bridgemate EI
. . Bridgemale | Bridgemate ! |
Bridgemate settings e Biena g et 1 Sooig g oo s
" Bridgemats Control
All Bridgemate settings can be changed via the menu Tools > S, o [T st
Options - Bridgemate tab. ¥ Shonenned eitcoomnesage. [T ] secncs
M agimumn results to show: | Unlimited -+ 3
. . o . . ontract
Bridgemate settings can be specified either by the scoring program ¥ howrecenere o oun et Show coircts using:
or by BCS. If you want your scoring program to control Bridgemate S .
settings, choose “Use Bridgemate Pro settings specified by Scoring Shon sexe ports e papectve of .
X i . L. ) d Hoith - sout ~ Declaer pional entry
program”. The settings information is included in the result (.bws) file vt s 35 I Leadend
. . v Member numbers
by the scoring program. Consult the manual of your scoring program fametoan sl k1 e —"
for more information on how to set Bridgemate settings through the e e e e "
scoring program. Select “Use Bridgemate Pro settings specified by P Board ader veifcalion hen e able ey st e e s
Bridgemate Pro Control” when you want to manually set the oo

Bridgemate settings disregarding the information provided by the

scoring program.

Displaying previous results

To enable the Bridgemate to display an overview of previous board results of this game, check the “Show previous
results” option. If you would also like to display your own score, check the “Show own result” option. Your table is
indicated by an * on the Bridgemate screen. To enable the players to display multiple overviews, check the “Repeat
results” box. Limit the number of scores to be displayed by entering a maximum number. To remove the limitation,
set the maximum to unlimited.

To display the board result percentage achieved so far, check the “Show percentage of own result” box.

When multiple sections are calculated as one, check the option “Group sections for results”. The percentage will be
calculated across all sections, and the results on all boards with the same number are shown in the previous results
overview. Especially in this case, it is recommended to set a maximum number of scores you want the Bridgemate
to show. Without doing so, the players will use up a greater amount of time reviewing the results at large sessions.

Displaying score points

The score points can be displayed from the perspective of the declarer or from the N/S direction of play. In the latter
case, score points are obtained by displaying E/W as an opposite score (4H — making 5, by E/W is displayed as -450
or -650). This applies both to the score points displayed in the verification screen for E/W and to the percentage
overview screen. The overview of previous board results always shows the scores as N/S scores.




Chapter 6: Additional Bridgemate functions 31

Entering results
Results can be entered in three ways: as overtricks / downtricks, as the total number of tricks won, or by using the

American style (tricks made/down). The default setting is overtricks / downtricks.

Displaying the pair number
If you do not wish to display the pair numbers in the round-information screen, disable the “Show pair numbers at
round info” function. This option can be used for team-of-four events.

Transmitting contracts

The Bridgemate offers users the option of feeding information to the server immediately after the contract and/or lead
card have been entered. This could for example be displayed on vuegraph presentations while the game is still
being played. If you wish to feed this information to the server, check the “Intermediate transmission of contract” box.

Board order verification

Check the relevant box if you would like the Bridgemate to check whether the boards are to be played in the logical
order. An error message will appear on the Bridgemate if the entered board number does not correspond to the
logical order. The logical order starts with the first board of the round and the numbers of subsequent boards should
be entered in ascending order. For example, if boards 1 to 3 are to be played in round A, the logical order is 1, 2, 3,.

Lead card
If you would like to enter the lead card on the Bridgemate, check this setting.

Member numbers

If you would like to enter the member numbers on the Bridgemate, check this setting. By default, players have the
option of leaving the entry blank when entering the member number. If entry of member numbers is compulsory,
check the “Blank entry not allowed” box.

Show contracts using
Use this function to specify whether the Bridgemate displays card symbols or letters for the contracts.

Autopower-off periods

The Bridgemate will automatically go into autopower-off mode if it remains idle for a while. The default setting is 20
seconds. To change this setting, enter a value between 5 and 60 seconds in “Autopower-off period”. In “Verification
message”, enter the length of time you would like the message “Verification by East or West” to be displayed.

Update settings during play

Option settings are sent to the Bridgemates when a new session is started and Bridgemates log in to the server. lItis
also possible to modify the Bridgemate settings during play and have the Bridgemates use these new settings.

To update the Bridgemate settings after the Bridgemates have already started the session, do the following:

Update the Bridgemate settings through the Bridgemate tab in BCS (Tools = Options) or in ACBLscore.
Go to menu Server > Show Tables.

Select the tables you wish to update the settings for. Note, CTRL + A will select all the tables at once.
Press the “Update settings” button.

Go to each Bridgemate Pro that is to have the new options settings.

Use the TD Menu #0 to reset the unit.

The new settings will take effect when the Bridgemate logs on again.

Note: The “Group settings” setting cannot be updated during a game. BCS always uses the initial game
setting from an F11 = BMS start.

NogrwbE

System functions

The Bridgemate has two separate system functions. In both cases, the Bridgemate communication cable must be
connected to the PC.
Changing Firmware

The Bridgemate is controlled by a piece of software in the internal memory. This software can be changed from
BCS. This means that the Bridgemate can be updated and new functions can be added. The language selection
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option for example can also be changed. In other words, the Bridgemate can be updated without requiring you to
purchase new Bridgemates.

To update the Bridgemate firmware, proceed as follows:

1. Connect the Bridgemate communication cable to the serial port (or the USB-to-serial Converter).

2. Goto Tools = Bridgemate = Bridgemate Pro update firmware.

3. Press Choose firmware file.

4. Select a Bridgemate firmware file to be loaded into the Bridgemate. These files have the extension ‘.bpf'.
Once the file has been selected, the location, version number and date of the file are displayed.

5. Switch on the Bridgemate and connect it to the PC. If the Bridgemate is not switched on, connect it first and
press OK.

6. The program is written in the Bridgemate. Wait to disconnect the Bridgemate until the text "Writing firmware
completed. Disconnect Bridgemate" is displayed.

7. The new program has now been loaded. Press OK to activate the Bridgemate.

8. Note: With the firmware update/reload, the Bridgemate will be “reset” to Section A, Table 1. Use the TD-Key
to change the Bridgemate to the desired Section and Table or the optional player entry of section and table..

The process will be cancelled if an error occurs during loading. When this happens, disconnect and reconnect the
Bridgemate to repeat the process. If the problem persists, replace the Bridgemate batteries.

WARNING
Only use this option as instructed. Incorrect use may result in faulty operation. Only use those files supplied by
Bridgemate.US and follow the instructions carefully. We strongly advise against any other use.

Bridgemate analysis

The Tools > Bridgemate - Bridgemate Pro analysis menu displays relevant information about the Bridgemate,
including version numbers, autopower-off time and/or correct operation of the Bridgemate.

When the 1% screen is displayed, connect the
Bridgemate Communications cable to the serial port
and click OK on the screen.

Bridgemate analysis report

When the 2™ screen appears, connect the mini plug
to the jack on the back of the Bridgemate; press OK
on the Bridgemate and then click OK on the screen.

Hardware wversion commanication cable: 1.4

The screen to the right shows a normal Bridgemate

Eridgemate functionality check: 0K
that is deactivated, i.e., it is in “sleep mode.” Hardware version: 1.z
Firmware version: Z.3.Za

Note: When the 2™ screen appears, you may first
press OK on the Bridgemate (wake it up), connect
the mini plug and then click OK on the screen.
Using this scenario, the Current status will display
“Bridgemate Pro main screen.” There are other
descriptions for other Bridgemate conditions.

Real-time Publication

Edition:

Chammel:

Laniage code:
Autopower-off period:
Contrast wvalue:
Current status:
Section:

Table:

Extended wersion (type 'a'
a

us

20 seconds

2

Bridgemate Pro main screen
A

z

During a game the rankings may be continuously displayed. The display will start after a few seconds (it opens your
browser — Internet Explorer, Firefox, etc.). As each new score is received, the display will automatically update to

show the latest rankings.

b Bridgemate® Control Software -
File BEEEEON Server Tools Help

Edit movernent

Synchronize [ recover
Update movement
Close rounds

Upload hand recards

Run Bridgemate Pro concurrently

Report Session

Report Session

[ Enable Live Ranking

[v Show number of boards

¥ Show percentages
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Replacing Bridgemate

If for whatever reason you need to replace a Bridgemate during a session, and you are unable to log off the
Bridgemate using the Reset TD menu option, proceed as follows:

- In BCS, go to Server - Show tables.
- Select the relevant table and press “Log off table(s)”. The Bridgemate will now be logged off from the server.

- Take another Bridgemate and use the TD-key to set this Bridgemate to the correct section and table number.
Also make sure to set the correct channel.

- Activate this Bridgemate. The Bridgemate will take over the position of the old Bridgemate.

Recovering the server

If the server is disconnected from the power supply (and batteries were either not installed or turned off), all data will
be lost and the Bridgemates will stop functioning. BCS is able to recover the old situation. Proceed as follows:

- Make sure the server is reconnected to the power adapter.
- In BCS, go to menu Session > Synchronize / recover

- Go to the “Recovery” tab and press “Recover server”. All information from the result (.bws) file will now be
moved to the server.
When recovering the server, it is important that all data had been moved from the server to the result (.bws) file. If
this is not the case, information that has not been moved to the computer will be lost and the server cannot restart
fully from the previous position. Make sure, therefore, that the data retrieval is always activated during the session.

Procedure in the event of data loss

The security of the board results entered in the Bridgemate Scoring System is given top priority. As the best defense
against data loss the Bridgemate system stores the results in multiple locations, namely:

e The Bridgemate memory
All results entered in the Bridgemate are sent to the server. At the same time, each result is also stored in the
Bridgemate’s internal memory. These results are stored until the Bridgemate is started up again for a new
session when the memory will be erased.
Until erased, data remains stored in the internal memory of the Bridgemate, even if no batteries are installed.
With BCS running, go to Session - Read Bridgemate locally. You will be prompted to connect the
Bridgemate Communications cable to a serial port (use the USB-to-serial dongle if necessary). Follow the on-
screen instructions.

e  The server memory
Results entered in the Bridgemate are sent to the server, and stored in the server’s internal memory. Itis
essential that the server is connected to a power source (batteries and/or power adapter). If there is no power
source, or in the event of power failure, all data will be lost.

e BCS result (.bws) file and log file
BCS continuously reads the new results from the server and processes these into the result (.bws) file. This
data is immediately written to the hard disk of your PC, ensuring the data is safe even in the event of power
failure. All results shown on the BCS screen have been written to the result (.bws) file.

BCS also has a log file, containing all the relevant events. All received results are written to this log file. To
view the log file, go to the Tools = Show log file menu. The actual file — BMProLog.log — is located in the
Bridgemate Pro folder — normally C:\Program Files\Bridgemate Pro.
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Special Note for Vista and Windows 7 Users: Because of Windows' “security precautions,” use the BCS
option to specify the location where the Log File is saved. See File locations, Chapter 3, for details.

e Session file in your scoring program
Lastly, the scoring program retrieves the results from the result (.bws) file. The scoring program stores the
results in its own files.

The results are therefore stored in five locations in total. In the event of data loss in one of the five locations, it is
possible to check whether the results are still stored at the next level up, and to reprocess the results from there.

Scoring program data loss

In the event of data loss in the scoring program, check whether the results are still stored in the BCS result (.bws)
file. The recommended method is to launch BCS from the Windows Start menu - All Programs - Bridgemate Pro.
Once BCS is started up, go to the File = Open menu and select the result (.bws) file (with the .bws extension) used
for your session. If the results appear on the screen, they have been stored in the result (.bws) file. The results can
now be reprocessed from the scoring program. For further information about processing Bridgemate results, see the
instructions included with the scoring program.

BCS data loss

If the result (.bws) file contains no results (see the above-mentioned step), it is possible to retrieve them from the
server and to read them in the result (.bws) file. The first step is to check whether the results are still stored on the
server. Use the Server = Show all scores menu for this purpose. All the results stored in the server will now be
shown. If the correct results are shown, it is possible to read them manually using the Server - Show tables menu.
Select all tables (hold down the Shift key and with the left mouse button down move the cursor over all the tables — to
select all the tables) and then click on “Retrieve scores”. The results of the selected tables are retrieved from the
server and processed into the result (.bws) file. The results can now be read by the scoring program.

Server data loss

If neither the server, nor the result (.bws) file, nor the scoring program contains any data, your next resort is to
retrieve the results from the individual Bridgemates. All results entered in each Bridgemate are stored in the internal
memory of the Bridgemate — until the Bridgemate is used for a new game! The information can be read into the
result (.bws) file using the manual connection between the Bridgemates and your PC. Use the Bridgemate
communication cable for this purpose. See Chapter 6 Reading results manually in Bridgemate for more information.

Warning

The board results are stored in the internal memory of the Bridgemate. Once the Bridgemate has been started up
again for a new session, the memory is erased and all the data removed. This procedure is executed after you have
pressed OK in the SECTION/TABLE screen and the Bridgemate has logged into the server. When retrieving the
results from the Bridgemate, please ensure that no players are operating the Bridgemates so as to avoid the
Bridgemate logging into the server and erasing all stored data.

Retrieving results from the log file

Results can also be retrieved from the log file. All results entered in BCS are stored in the log file. To view the log
file, go to the Tools = Show log file menu. The selected rows can be copied and saved to an empty text file and
printed. Automatic processing is not possible; the results must be entered manually in the scoring program. The
actual file, BMProLog.log, is located in the BCS folder, normally C:\Program Files\Bridgemate Pro.

Special Note for Vista and Windows 7 Users: Because of Windows’ “security precautions,” use the BCS option to
specify a non-Program Files folder where the Log File should be saved. See File locations, Chapter 3, for specific
details.

Multiple bridge clubs playing simultaneously

There may be times when two or more bridge clubs are playing at the same time in one building — each with their

own client PC. As the Bridgemate server can incorporate a specific Section/table number only once at a time, it is
not possible for two clubs to make use of one server simultaneously. Both bridge clubs will therefore require their
own server.

It is of course vitally important that they do not interfere with each other. This problem can be rectified by:
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e each club using different Section letters. In this case the clubs can communicate with their Bridgemates on
the same channel.

e the systems communicating over different channels. The first club sets its system (server and Bridgemates)
to channel 0, while the other uses channel 1. A third and fourth club can then use channel 2, 3, etc. This
method enables multiple clubs to use the Bridgemate scoring system in the same area simultaneously with
the same Section letters without causing any interference.

Large tournaments

During large tournaments, more than one server will be required to control over 128 tables. The layout of the tables
is important in this respect. If the tables are outside the range of the server, an extra server will be needed to
increase the range. The Bridgemate Scoring System supports multiple servers over a network. In principle, this
network can support an unlimited number of tables. The following guidelines must be observed:

- You will need a fully operational network in which all used PCs are interconnected, enabling them to access
and process files.

- Only one result (.bws) file is used, containing all session data and board results of all tables.

- The scoring program is running on one of the computers in the network. It is not necessary for the scoring
program to be running and/or the result (.bws) file to be stored on one of the client computers that is running
BCS. From an organizational point of view, it may be easier to use a separate PC containing the scoring
program and result (.bws) file. Client PCs access the result (.bws) file over the network.

- Each Bridgemate server is connected to its own PC (=client) where BCS is running. Do not connect two
servers to one client PC; although technically feasible, it may cause unnecessary confusion, as both servers
are using the same client name. Worse still, it may even be counter-productive if both servers are operating
over the same channel.

- Use different channels for each server, especially if the servers are within range of each other. Only use the
same channels if you are sure that the servers are not interfering with each other (e.g., in different
buildings).

Using ACBLscore and Bridgemates on a Network

ACBLscore and the Bridgemate Scoring System can be used on a network where the ACBLscore program and
Bridgemate Control Software (BCS) software both operate on a single computer. Each separate client computer will
run its own BCS program and open the single result (.bws) file, e.g., 070904E.bws, on the ACBLscore computer.

ACBLscore Computer

- Configure the C:\ACBLSCOR\GAMEFILE folder for Network sharing and “change my files” by a remote computer.
- In BCS, Server > Show Tables, highlight tables controlled on the remote computer(s) and click Delete Table(s).

- The BCS option (Tools - Options > General) “Mode = Club [single computer]” should be checked.

Remote Computer(s)

- Open BCS program and check the BCS option “Mode = Club [single computer]” (Tools > Options > General).
- Use File > Open to manually open the *.bws file on the ACBLscore computer.

- BCS lower left: Highlight tables to add to this client - right click and click Add to client

Note: The tables not “added” above, will not be in this “remote” server.

If the Bridgemates working into the Remote Computer(s)’ server(s) are configured for different channels, the BCS
changes need only be made at the Remote Computer(s).

Contact Bridgemate.US for more detail.
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Chapter 8: Using Bridgemates with ACBLscore

ACBLscore (Windows), starting with version 7.45, supports the Bridgemate Scoring System (BCS). This chapter
describes how to use ACBLscore to activate BCS and retrieve information from the result (.bws) file.

Installation

Software Required

e ACBLscore (Windows version) v8.15 or later — download from www.acbl.org
e Bridgemate Control Software install program — see website www.bridgemate.us or Flash Drive.

Install software

The BCS program controls communication with the Bridgemate Pro hardware and exchanging data with ACBLscore
through the result (.bws) file. The default installation folder is C:\Program Files\Bridgemate Pro. If BCS is installed in
another folder, you will need to identify the “different” installation folder to ACBLscore.

e BCSsetup.exe installs the BCS software. It is recommended you accept the default installation folder.
Special Note for Vista, Windows 7,8/10 Users: Because of Windows’ “security precautions,” use the BCS
option to specify a non-Program Files folder where the Log File should be saved.
See File locations on Page 19, Chapter 3, for specific details

e Install ACBLscore Version 8.15 or later.

Note: Normally, BCS and ACBLscore will be installed on the same “client” PC.

Connect the Bridgemate Server to the Computer.

The server has a standard 9-pin, serial port connector. If your computer has a serial port, connect the server directly
to that port. If there is no serial port, use the ATEN plug-and-play USB-to-serial (RS-232) converter to add a
hardware serial port to client PC. Insert the converter in a free USB port. If the converter does not install
automatically, see the converter’s instructions and driver CD for the installation.
Note: The same USB port should always be used! Do not use a USB hub.

See Special note when using the USB-to-serial converter on Page 10, Chapter 2.

The 64-bit Windows 7 and Vista require USB-to-Serial Adapter driver version 3.3.0.1.
All 32-bit and previous Windows’ versions require the USB-to-Serial Adapter driver version 2.0.2.1.

The Server requires electric power — supplied by an external power adapter, or 4 AA batteries.
e When the server is being used with the power adapter, the 4 batteries should be installed to provide “backup
power if there is an AC power interruption. This will preclude inadvertent loss of scoring data.
e When powered, the Server is active — waiting to receive radio signals from Bridgemates; thus, to conserve
the batteries, the battery-power rocker switch on the top of the server should be “off” (the “0” position), or one
or more of the batteries should be removed when the server is not in use.

BCS Setup

Verify BCS/server connectivity

Once the server has been activated — by using batteries or the power adapter —
start BCS to see if it finds the server. Normally, BCS is started by ACBLscore;
but, to verify server connectivity, Start BCS directly from the Windows start menu
at this time. [Go to Start - All programs > Bridgemate Pro - Bridgemate
Control.] A small text bar will display while it searches for the server.

The BCS screen will appear and the server details, displayed in the upper left
“Server Information” section, should show “Connected.”

Verify that the region is set to North America.
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Set BCS options

Go to menu Tools - Options - General
“Club (single computer)” o . Optional
“Disable server detection”  (unchecked) oo l_’i?/w“”gs

+ Club [single computer] v BElose program at end of session

“Erase original records of deleted scores” MUST be checked whgn lising ACBLscore

rhnamenl

Wiew ] Log file] Scoring program]

|v Erase original records of deleted scores

On the “Log file” tab: with a Vista or Windows 7 PC use the B S it s e S
‘Log files are saved in’ = Other folder
See File locations on Page 19. Bridgemate server
[ Dizable server detection
See Chapter 3, Program Settings (Options), page 19 for option (Does not disable server detection at startup)

settings on the General, View, Log file and Scoring program tabs.

Autopower-off period: m
Go to Tools - Options - Bridgemate

Options should be set as appropriate. See the laminated
Quick Setup Guide and Chapter 6, Bridgemate settings, page 30.

The Bridgemate Control Software is ready for use with ACBLscore.

Close the BCS program.

Configure Bridgemates
1. The TD (Tournament Director) Key is used to configure each Bridgemate.

2. Each Bridgemate may be assigned to its own Section and Table: Al, A2, A3 .....,B1,B2 ..., etc. — or —
Bridgemates may be configured for manual entry of the Section and Table by players at the table when a
new game/session is started. See Chapter 5, page 23 — Activating the Bridgemate.

3. The default RF (radio frequency) channel is 0. If you experience transmission troubles with this channel,
change to another channel. The channel selected in BCS for the Server must always be the same as the
one set in all the Bridgemates. The frequency range for North America is 902 ~ 927 mHz.

Note: Bridgemates automatically shut off power when not in use. Batteries need not be removed when not in use.

When Bridgemates are activated and communicate with the server, a low-battery notice will be displayed
when the battery life is at 25-30%. Typical life is 250~300 sessions, so — even with a low-battery notice —
there is enough battery power for several more sessions.

When the Bridgemate batteries are “critically” low, there will be a brief “battery low” note on the screen and
the Bridgemate will shut itself off. The batteries must be replaced before play can continue.

The Bridgemate Scoring System is now ready to be used with ACBLscore.

ACBLscore Setup

When the background screen is green, the program is in
Club Mode and Game Options will be visible. If the
screen is pink and/or Game Options is not visible, switch
B Tournament/Club Mode »
to M (from Tournament mOde)' Game Options P Allow Edit of Names in Game File
TALIOW Auto Stratification

srsion W7.49 08/13/2007 Coppright [c) 1991.#1 Allow Remote score entry

P Help/New & Utilities @

et Path
et Printer

B et Screen Font

=
5

= L

Enable Bridgemate functionality

Go to: Setup > Game Options. It is recommended that all 3 options be selected.

Set Bridgemate Options in ACBLscore

It is recommended that Bridgemate options be configured in BCS for control by the scoring program — ACBLscore.
Once the Bridgemate options have been set, they will be used for all future games — until changed.
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When a game is first “opened,” press F11 to display the “Select Command” screen.

Options” or highlight the line and press ENTER.

Typical club game options are shown here.

¥ Allow entry of player numbers at remote

I~ Every player must enter a player number

¥ Auto Strat when posting names from remote

¥ Show previous results of the board just played

Maximum results to show (0-127, 0 = unlimited) 0

¥ Show your own result in the list of previous results

¥ Enable the possibility to repeat the results

¥ Show the percentage on the board just played

¥ On = Show score from perspective of declarer, Off = N-S
¥ Show pair numbers in the round info screen

¥ Verify the board number on correct order of entry

¥ On = North American results entry method, Off = European
¥ On = Show contract as letters, Off = symbols

Remote auto power off time (5-60) 20

Verification message display time (1-7)) 1

Press FS when done

OK Cancel

Set up a Game

1. With the BCS program already in-
stalled, create the game file and set
up sections in the normal manner.

Special considerations are:

2 Fick-ups - Sequence by N-5 pair number
3 Trawvelers - Sequence by N-5 pair nurmber

Ele [t ew Zection el
1

N Seluct command

070904 (A) - F11 or AlH. for Command list CibA 1o Add 8 section

How Filo, Ho Sections defined CLUB made

Frinter Gananc Manow

-CHE VErsion W7.49 D81 32007 Copymight [c) 1

191-2007 ACBL

Left click on “BMO Remote

Select posting method

Pick-ups must be: “Sequence by table number”

Press ENTER for No

Use Remate Server for score entry

Cancel

Click “Yes” or use cursor key to highlight “Yes” and press ENTER for "Use Remote Server for score entry”

2. ACBLscore automatically interrupts “posting” as of the penultimate (next-to-last) round to accommodate
preparing a one-round-to-go report. After all results for the next-to-the-last round have been posted, one or
more additional ACBLscore “post” commands will be needed to complete a game.

3. To set up a new game (especially with multiple sections) in ACBLscore more qwckly, you may bypass event

rating. See Quick Setup Tip on page 40.

BMP

EMS

4. When all Sections are set up, start BCS software. Em
The Bridgemate commands are at the “end/bottom” EMN

of the F11 commands; or, key “BMO” to go to the last entry —  BM©

in order to see all the commands.

Posr scores from Remote
Start Remote server - reset server - beginning of session
Restart Remaote server - do NOT reset server
Locate Remnote server

Post names from Rernote

Cancel

Rermoate Options

e

e g

~

Help

5. The BMO command is used to set Bridgemate options, when BCS software is configured to use options
settings specified by the “Scoring Program.”

6. The BMS command is only used to start a new game/session. This will RESET the BCS software, server
and Bridgemates — erasing any existing settings.

7. The BMR command is used to “restart” BCS without losing data already entered. This may happen when
the PC has been stopped, e.g., due to a power failure, PC reboot, or any other reason for BCS being shut
down during a session. There is no loss of data when BMR is used to restart the Bridgemate software.

8. Special note: If Bridgemate use was not enabled as shown in item 1 above,
there will be a BME command visible. This should be used to “enable” the
Bridgemate Scoring System for each section in the game.

EME
BML

R [E

[rax]

Enable this section for
Locate Remote server
Rermnate Options

Remote

Cancsl
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Read data from the Bridgemate Scoring System into ACBLscore.

» The ACBLscore screen is normally visible on the PC, and the BCS screen is minimized.

» When you first key F11 (or F9) the keyboard may appear to be inactive. Use the mouse (or touch pad) to

move the cursor within the ACBLscore screen and left click. This will normally enable/activate the keyboard.

Player Numbers

If Player Numbers are to be entered at each table, this will be done as each table starts to use a Bridgemate.

After play has started, names are read from the result (.bws) file into ACBLscore — using the BMN command.
KeyF11 > B> M > N -or- F11 - End & highlight the BMN command line; Press ENTER

Special Note: In multi-section games the BMN command must be issued separately for each section.

ACBL Life Members enter their alpha character as a number. J=1, K=2, L=3, M=4, N-5, 0=6, P=7, Q=8 &
R=9. A “Life Master ACBL Alpha = Number” file is on the Bridgemate Flash Drive. There is a Life Master
ACBL Alpha=Number label on the bottom of each Bridgemate.

Non ACBL member “pseudo” numbers: When there are regular players who are not ACBL members, each
non-member may be assigned a pseudo number that may be used. Pseudo numbers are in the ACBLscore
database preceded by the “#” character. For example: Player number 19 will be “#19” in the database.

For each number that is found in the database, the player's name will be entered into the Player Names (F3)
file. If a number (ACBL member or pseudo) is not found — or no number has been entered — there will be no
entry made in the file for that player.

The BMN command will be available whenever ACBLscore’s Bridgemate Options is configured to “Allow
entry of player numbers at remote.” ACBL member numbers as well as non-member “pseudo” numbers are
read into ACBLscore and entered in the Names (F3) file. The BMN command must be executed separately
for each Section in a session. If the ‘Auto Strat when posting names from remote’ option is checked, a strata
will be assigned to each pair based on the players masterpoints in your ACBLscore database; otherwise all
names (read in from Bridgemate) are entered in the Names file as strata “A” until the STRAT command is
run. The F11 - STRAT command is used to assign the correct strata to each pair;.

Note: Use the F3 command to manually enter the names of new players and those without a number.

Use the up-arrow key to move into the player name field when there is only one player in a pair.

Before or after the “auto stratify,” manually enter the names of players not shown in the Player Names file.
With “Allow Auto Stratification” — see page 37 — you will be prompted to confirm the strata for each team.

Note: When using a Mitchell-Rover movement, the will be no opportunity for the “bump” team (that moves to

different tables) to enter their player numbers. Use F3 to enter the names of the “bump team” players.

Board Results

Once boards have been played and the results recorded on Bridgemates, the information may be “posted”
into ACBLscore. Typically, this is done periodically throughout the game. This will also enable the scorer
(usually the director) to spot any anomalies that might occur.

The BMP command (F11 followed by B-M-P — or “End”) is to read board results from Bridgemate and post
them into ACBLscore. Posting will automatically stop at the end of the penultimate round — to accommodate
the preparation of a next-to-last round report. After the penultimate round has been posted, one or more
additional “post” commands are needed to read all of the final results. Ctrl-P is a shortcut for this command.

When a board is not going to played at a table, it should be recorded as a “no play.” Enter “0” on the “Contr”
line and press OK. E/W should approve the “No play” result. When the result is “posted” into ACBLscore, it
is treated as a “Late play.” This must be resolved (within ACBLscore) before the end of the game:

o Ifitis atrue late play, the actual score may be entered after the board is played.

o If the players actually “passed out” the board but incorrectly entered in to the Bridgemate, you can enter
“0” for the score in ACBLscore.

0 A nice alternative may be to give the players an ACBLscore “no play” (NP). This will then (for this board)
give each pair their average of all the other boards they have played.

o A fourth alternative might to be assign arbitral scores.
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e When posting results in a multi-section session you will see: Select score posting option
1 Post all sections configured for remote entry
2 Post only Section x

If you wish to post only scores for the “active” session, _Cance |
- click on “2 Post only Section C” and click OK, L) ¥ of sections . # of events |
- press “2" and press Enter, or CLUB mode

- use the arrow keys to highlight the line and press ENTER.  z-scores Fa-Names F4-Leaers F5-Recan F7-Change Fé-List Fe-Get

Otherwise just press ENTER to post scores for all sections.

e The ACBLscore screen displays the number of rounds whose scores have all been posted. After all of the
rounds being played are shown as “entered,” the section/game is over. Results and reports can be
displayed and printed using F4, F5 and/or F8 as desired.

o Before a score has been accepted in a Bridgemate, the TD key can be used to separately assign an arbitral
score [AVG - (40%), AVG = (50%) or AVG + (60%)] for E/W and for N/S.

e Scores already accepted/recorded in a Bridgemate — but not yet posted into ACBLscore — can be corrected
using the TD Key. See Erasing entry, chapter 5, page 29. Insert the TD Key, press ‘3, OK to confirm
“Erase result,” enter board number and press OK. The erroneous result is erased and the new may entered.

e  Scores already posted into ACBLscore must be corrected there. T0 erase a score in ACBLscore — type “X”

e See page 27 for Special entries: Pass-out and board not played.

Quick Setup Tips

1. Early game/session setup:

Single or multi-section games/sessions may be set up early in ACBLscore. Extraneous information such as
expected movement, Event rating (stratification criteria), Event Information (Tournament data), etc., may be
entered before the stress of actual play being started. It is suggested ACBLscore be “preset” with fewer tables
than are actually expected in a single or multi-session game/session. Do not start BCS at this time.
> Then, when play is ready to start:

a) Use F9>5 Change movement parameters and change to the actual movement/tables/etc.

b) In a multi-section session, repeat the F9>5 Change movement parameters for each section.

c) After the all the movement(s) have been finalized, use F11->BMS to start BCS — and the session.

2. To setup a session (with one or more sections) more quickly, bypass the Select event rating
masterpoint portion of normal setup. Just select “13 No masterpoints” when i ¢ TrroLn_w
the “Select event rating” screen appears. 13 Mo rr|a=|::;t|=er';:u:|ir|t:5;

Later, after play has started, use “F9>10
Set masterpoint rating to create stratification for the game/sections.

Select option (ESC to Exit)

4 Change scaring method
105 rpoint rating

11 Ammimr b e e ma T 2

Change Movement after Game has started Select option (ESC to Exit)

To the extent possible, each session/game should be as fully
configured as possible in ACBLscore before starting BCS. Movement
changes can be made in ACBLscore after the BCS program has been
started — to accommodate the arrival of new player(s) or one-or-more
“no show” players. The ACBLscore manual more fully describes how
to make changes.

1 Change posting method

2 Change number of plaved rounds
3 Change section letter and/or color
4 Clualification / Eligibilit,

5L Change mowvement parame
b Factorto a different average
Key F92>5 Change movement parameters and ENTER (or ‘left’ mouse ¢ Settie-breaking spread
click). After the new parameters have been entered and accepted, ACBLscore will automatically update the result
(.bws) file and effect the changes in BCS.

ters
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Always post all scores before making any movement changes in ACBLscore. Especially if adding pairs or
making special changes using EDMOV, post all scores using ‘F112>BMP’ or Ctrl-P — before making any

changes.
Note: When BCS is updated, there will normally be a “Report”

E Re port

. . « " . Movement updated by external program Pl
screen displayed. This screen may “closed” or BCS will
. . . Deleting old movement data section & - table 1: 0K
automatically close it after 1 minute. hdding round 1: OE
Adding round Z: 0E
When ACBLscore updates BCS, “deleted” table(s) or section(s) may e o o
not actually be removed. Thus, it is recommended that any “deleted” bading round §: oK
table(s) and/or section(s) be manually deleted/logged off in BCS to Adding rewsd 7 OK
preclude possible confusion if someone inadvertently activates a i T 5e ok
deleted-table or deleted-section Bridgemate. Updating movenent ssction 4 - table 1: OR
Deleting old movement data section & - table EZ: 0K
Adding round 1: 0E
. Adding round Z: 0E w
Change before any Bridgemates have been used

When the changes can be made before players have started entering|___Frint
their member numbers and/or results, instruct players to delay any
entries until the changes are made. After the ACBLscore changes have been made and BCS has been updated,
players may begin normal Bridgemate use.

Change after people have started member number and/or score entry

e Ask players to hold up any further Bridgemate entries until the movement change has been completed.

o If the movement change will move pairs around, player numbers will need to be entered manually, later.
However, if pairs remain at the same tables (even though they may now have different team numbers, e.g.,
when change from a 5 table Howell to a 6 table Howell, or a 6 table Howell to a 7 table Mitchell, ACBLscore
BMN (Post Names from Bridgemate) will correctly assign pairs to the correct tables — when the “member-
number” option is being used.

¢ Make the movement changes as noted above. ACBLscore automatically updates BCS with the new info.
Note: When BCS is updated, there will normally be an “update” screen displayed. See above.

Replacing Bridgemate during play

If a Bridgemate appears to have stopped working, use the TD Key and “reset” (0). The unit should “log off” and be
ready to be returned to service.

The alternative is to program a spare Bridgemate as a replacement.

e In BCS go to Server > Show Tables — highlight the table number involved (the Status indicator should be
green) — click on “Log off table(s).”
e Log-in the replacement Bridgemate as the desired Section/Table. If necessary, use the TD Key to program
the replacement unit for the desired Section and Table.
e The reprogrammed Bridgemate should now be useable.
e If results had already been entered using the “old” Bridgemate, use Server - Read scores to see if the
server has the results already entered — if so, no further action is needed.
However, if some-or-all of the already entered results were deleted, use Session = Synchronize /
Recover > Recovery & Recover Server to update the server with the results already recorded in the
result (.bws) file.
CAUTION: When there is a Recovery, it is possible that results entered at other tables at about the
same time may be lost and need to be re-entered.
o |If the replacement Bridgemate displays SYSTEM NOT ACTIVATED YET screen, it may be necessary to
“recover the server” as described above.
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Swiss Teams and Knockouts

ACBLscore does not support using the Bridgemate wireless scoring system for team events. There is a third-party
software that may be used for team games. The final results are then entered manually into ACBLscore. Detailed
information is available on the Bridgemate.US website: Team Games using Bridgemates

Procedures when using Player entry of Section/Table

Check each Bridgemate as it is placed on a table. Press the OK key; if the "Bridgemate Pro" screen appears, the
unit is ready for Section/Table input. If the display is anything other than "Bridgemate Pro," reset the Bridgemate.

For multi-section games, the suggested procedure when placing Bridgemates Pro on tables is to:
e wake with OK,

press OK to go to Section/Table screen,

use +/ - to select Section assigned to the table,

press OK to put cursor on the Table line.

Now, when players start each Bridgemate, they will only need to enter the table.

Special Reports

Play data may be copied from BCS and used to prepare special reports — such as a summary of the results of each
board played.

e See Creating Reports, Chapter 3, page 14 on how to copy play data from the BCS screen.

0 Paste the copied data into an Excel Spreadsheet.
o With the new data highlighted, select Data - Text to Columns
Select “Comma” as the delimiter.

Table size
~
Murmber of columns: 7 £

Mumber of Fows:

e WORD document: AutoFit behavior

0 Paste the copied data into a Word document. ) o el el

o Highlight the new data, select Table > Convert > Text to Table @i
Complete the “Convert Text to Table” screen as noted for @) d
“Commas,” “AutoFit to contents” and number of columns in your Table stvle: (none)
data (7 is shown here). Sl o 2t

0 The table that is created will be highlighted. Select Table > Oparagraphs  ® Commas

Convert > Table to Text. This creates text which may be pasted ) Tabs O other:

into an email message or uploaded to a website.

e OpenOffice.org: A simpler procedure is to use the spreadsheet Lo J[ concel |
program of OpenOffice.org which is “free to download, use, and
distribute” at http://download.openoffice.org/

0 Paste the copied data into the OpenOffice.org calc spreadsheet. On the “Text Import” screen that will

0 Adjust column widths — if desired.
o Highlight and copy the data for your report.

e EXCEL spreadsheet — alternate procedure (advanced Excel user): There is an alternate procedure whereby
data can be “imported” into Microsoft® Excel from the game’s .bws data file.
0 Change the file suffix on the game data file from .bws to .mdb (e.g, 130615A.bws > 130615A.mdb).
This file is normally in the C:\ACBLSCOR\GAMEFILE folder.

0 InExcel: Data > Get External Data - From Access > find & select the renamed .mdb file

0 A “Select table” window will appear. Highlight the “Received Data” table and click OK.

0 On the “Import Data” window select “Table” and “Existing worksheet” - Click OK

0 The “Result” column will be in the European “Up/down tricks” format. To create an “American style”
Results column use an Excel formula — such as this:

=IF(K2="="LEFT(J2,1)+0,IF(LEFT(K2,1)="-",(K2+0),LEFT(J2,1)+K2))
o Highlight and copy this new “result” column; then paste it as “values” into the “Result” column.
0 Delete un-needed columns.


http://www.bridgemate.us/how-to-guides/team-games-using-bridgemates/
http://download.openoffice.org/
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It is suggested the BCS column heading “NS/EW” be changed to Declarer. Below is a sample report.
Note: This example includes the “Lead” card which may be captured when options are controlled by BCS.

Section Board NS EW Declarer Contract Result Lead
A 1 2 3 N 4 H -2 H4
A 1 3 5 N 4 H -2 H4
A 1 4 7 S 3 NT -1 SJ
A 1 5 9 N 3 H -1 H4
A 1 6 2 S 3 NT -3 DA
A 1 7 4 N 4 H -1 c2

Expanded detail available on Websites.

With the Bridgemate Scoring System more detail is available about each board than the limited information from
ACBLscore. The Declarer, Contract and actual result — when coupled with ACBLscore info — provides players with
more information than they have ever had. The detail is even more significant with pre-dealt hands using a dealing
machine — or the analysis of player-entered boards when using BCS version 2.8.29 (or later).

Bridgemate.US has been working with three bridge-specific websites that are easily set up and controlled by a non-
programmer. Our test sites are: www.waynesboro.bridge-club.org, www.bridgewebs.com/waynesboro/ and
http://site.pianola.net/wintergreen-bridge/. Visit www.bridge-club.org or www.bridgewebs.com or www.pianola.net to
review their offerings and pricing. All three offer a trial period.

Several clubs/units have developed their own website-display software. Also, ACBL offers a “Clubs Results” service
to ACBL sanctioned clubs. When a game is finished, it is very easy to upload 2 files (3 — with hand records) and the
result is immediate. More information is on our website www.bridgemate.us/product/website-displays/

Using Bridgemates Il and Bridgemates Pro together

If you have both a Bridgemate Pro and a Bridgemate Il system, it is possible to use both systems together to score a
single event. As Bridgemates Il only communicate with a Bridgemate Il USB server and Bridgemates Pro only with a
Bridgemate Pro ‘serial’ server, it is a requirement that both servers are connected to the computer.

To use both Bridgemate Pro and Bridgemate Il in one event:

1. Connect both a Bridgemate Il USB server and a Bridgemate Pro serial server to your computer. The
Bridgemate Pro server can be connected through the USB-to-serial “dongle.” Please refer to the Bridgemate
Pro manual for operating instructions of the Bridgemate Pro server.

2. Start the Bridgemate system from your scoring program. This will start the Bridgemate Il system first.

3. After BCS has been loaded and Bridgemates Il have been activated, click on Session = Run Bridgemate
Pro concurrently. This will load a second copy of BCS and this copy will start the Bridgemate Pro server.
Both systems may now be used together.

4. When the session is finished, manually close both instances of BCS.

Please keep in mind the following when working with both systems together:

o All tables will be loaded into the Bridgemate Il server and the Bridgemate Pro server. You decide which
tables are used by the Pro system, and which by the Il system. As a consequence, both systems may show
that certain tables are not activated yet within their server, since these units are logged into the other server.

e You may wish to use Bridgemate Pro’s and II's in separate sections, e.g., Section A uses Bridgemates II,
and Section B uses Bridgemates Pro. However, the units may even be “mixed” within a Section.

e Scores are exchanged between the two systems. Scores entered in Bridgemate Pro will also appear on the
Bridgemate Il scoring devices, and vice versa.

e A scoring-program movement update will first be carried out by Bridgemate Il, and a few seconds later by
Bridgemate Pro. This is done automatically.

o If the second instance of BCS is accidently closed, it can be started again by using the same BCS menu:
Session > Run Bridgemate Pro concurrently. It will remember that it has already been started before and
will not start from round 1 but instead continue from where it was when the program was closed.

e Since Bridgemate Il has more settings than Bridgemate Pro, Bridgemate Pro will only use those settings that
are for Bridgemate Pro. For example, names may appear on Bridgemates Il but will not on Bridgemates Pro.


http://www.waynesboro.bridge-club.org/
http://www.bridgewebs.com/waynesboro/
http://site.pianola.net/wintergreen-bridge/
http://www.bridge-club.org/
http://www.bridgewebs.com/
http://www.pianola.net/
http://www.bridgemate.us/product/website-displays/
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Declaration of Conformity

Federal Communication Commission Declaration of Conformity (DoC) Statement

Responsible party: Bridge Systems BV

Address: Postbus 21570, 3001 AN, Rotterdam, The Netherlands
Hereby declares that the product:

Product Name: Bridgemate® Pro Wireless Scoring System

Table Terminal: Model No: BM11R11B FCCID: UVIBM11R11B
Serial Server: Model No: BS10R11B FCCID: UVIBS10R11B

Conforms to the following regulations: FCC part 15, subpart B, section 15.47

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15
of the FCC rules. These limits are designed to provide reasonable protection against harmful interference in a
residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications. However,
there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of the following measures:

Reorient or relocate the receiving antenna.

Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This
device may not cause harmful interference, and (2) This device must accept any interference received, including
interference that may cause undesired operation.

Caution:
Any changes or modifications not expressly approved by Bridge Systems BV could void the user's authority to
operate the equipment.

Canada Regulatory Compliance Statement

This device complies with Industry Canada Standard RSS-210. Operation is subject to the following two conditions:
(1) this device may not cause harmful interference, and (2) this device must accept any interference, including
interference that may cause undesired operation of the device.

Ce dispositif est conforme avec la norme CNR-210 d’Industrie Canada. Le fonctionnement du dispositif est sujet aux
deux conditions suivantes: (1) le dispositif ne doit pas causer de brouillage, et (2) le dispositif doit accepter tous
brouillages, incluant tous brouillages.

Table Terminal: IC: 6946A-BM11R11B
Server: IC: 6946A-BS10R11B

June 2017
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